V11.5
Gold Edition
Training Guide

Updated Jan 2015
Contents

1. Introduction .................................................................................................................. 5

2. Getting Started ........................................................................................................... 6
   Exercise 1 Starting Read&Write 11.5 Gold ................................................................. 6
   Exercise 2 Positioning the toolbar .............................................................................. 7
   Exercise 3 Understanding the toolbar ...................................................................... 7
   Exercise 4 Setting up toolbar display options ......................................................... 10
   Exercise 5 Changing the toolbar colour ................................................................. 11

3. Reading .......................................................................................................................... 13
   Exercise 1 Reading text in documents ..................................................................... 13
   Exercise 2 Changing the voice .................................................................................. 14
   Exercise 3 Changing how words are pronounced .................................................. 15
   Exercise 4 Instructing the system to speak as you type ......................................... 16
   Exercise 5 Setting up Screen Reading ..................................................................... 17
   Exercise 6 Changing the speech highlighting ......................................................... 18

4. Reading Webpages ........................................................................................................ 20
   Exercise 1 Reading webpages in Internet Explorer ................................................. 20
   Exercise 2 Reading webpages in Firefox .................................................................. 20
   Exercise 3 Reading webpages in Chrome ............................................................... 20

5. Reading Inaccessible Text .......................................................................................... 22
   Exercise 1 Using the Screenshot Reader .................................................................... 22
   Exercise 2 Screenshot to MS Word .......................................................................... 23
   Exercise 3 Changing the Screenshot Reader options ............................................. 24

6. Converting Text into Sound Files ............................................................................... 27
   Exercise 1 Converting text into sound files ............................................................ 27

7. Reading Dragon Recognised Text .............................................................................. 30
   Exercise 1 Reading Dragon Recognized Text .......................................................... 30

8. Working with Daisy Books ......................................................................................... 31
   Exercise 1 Reading Daisy Books .............................................................................. 31
   Exercise 2 Navigating through a Daisy Book ......................................................... 32

9. Using the Pronunciation Tutor .................................................................................. 34
   Exercise 1 Checking how words are pronounced .................................................... 34
   Exercise 2 Creating syllable exceptions .................................................................. 35

10. Reading PDF Documents ........................................................................................... 37
    Exercise 1 Reading PDF documents ........................................................................ 37
Exercise 2  Reading a PDF file in Adobe using PDF Aloud ........................................38  
Exercise 3  Altering the PDF Aloud options.................................................................39  

11. Spell Checking ...........................................................................................................40  
Exercise 1  Using the Spell Checker ...............................................................................40  
Exercise 2  Using Spell as I Type ..................................................................................42  
Exercise 3  Adding words to the Custom Spelling Dictionary .......................................43  
Exercise 4  Changing the Spelling settings ....................................................................44  
Exercise 5  Using the Auto Correct file ..........................................................................45  
Exercise 6  Reviewing spellings ......................................................................................46  
Exercise 7  Adding a phonetic replacement ....................................................................46  
Exercise 8  View your spelling log ................................................................................48  

12. Predicting Text ..........................................................................................................50  
Exercise 1  Using Prediction .........................................................................................50  
Exercise 2  Teaching the Prediction new vocabulary patterns .......................................52  
Exercise 3  Downloading prediction word banks ............................................................53  
Exercise 4  Changing the Prediction window ..................................................................53  
Exercise 5  Setting up prediction speech options ............................................................55  
Exercise 6  Learn vocabulary patterns ..........................................................................57  
Exercise 7  Setting up phonetic replacements ................................................................58  
Exercise 8  Setting up the prediction context level .........................................................59  
Exercise 9  Adding prediction word banks ...................................................................60  
Exercise 10 Adding individual words to the prediction word bank ..................................61  

13. Using the Dictionaries ...............................................................................................64  
Exercise 1  Using the Basic Dictionary ..........................................................................64  
Exercise 2  Using the Advanced Dictionary ....................................................................65  
Exercise 3  Using the Web Dictionary ............................................................................66  
Exercise 4  Using the Picture Dictionary .......................................................................66  

14. Using the Word Wizard ...........................................................................................68  
Exercise 1  Searching for words using the Word Wizard ...............................................68  

15. Using the Sounds Like and Confusable Words facility .............................................70  
Exercise 1  Identifying sounds like and confusable words ..............................................70  
Exercise 2  Adding additional confusing words .............................................................72  
Exercise 3  Returning Always Ignored words ..................................................................73  

16. Using the Verb Checker ...........................................................................................75  
Exercise 1  Using the Verb Checker ...............................................................................75  

17. Using the Calculator ..................................................................................................77  
Exercise 1  Using the Standard Calculator ......................................................................77
<table>
<thead>
<tr>
<th>Exercise</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Using the Scientific Calculator</td>
<td>78</td>
</tr>
<tr>
<td>3</td>
<td>Converting values in documents</td>
<td>78</td>
</tr>
<tr>
<td>4</td>
<td>Using Variables and Constants</td>
<td>79</td>
</tr>
<tr>
<td>5</td>
<td>Evaluating calculations within documents</td>
<td>80</td>
</tr>
<tr>
<td>6</td>
<td>Scanning to HTML</td>
<td>81</td>
</tr>
<tr>
<td>7</td>
<td>Scanning from a digital camera</td>
<td>82</td>
</tr>
<tr>
<td>8</td>
<td>Scanning from a file</td>
<td>83</td>
</tr>
<tr>
<td>9</td>
<td>Scanning multiple documents</td>
<td>84</td>
</tr>
<tr>
<td>10</td>
<td>Scanning single pages</td>
<td>85</td>
</tr>
<tr>
<td>11</td>
<td>Performing a scan</td>
<td>86</td>
</tr>
<tr>
<td>12</td>
<td>Adding search engines</td>
<td>87</td>
</tr>
<tr>
<td>13</td>
<td>Brainstorming</td>
<td>88</td>
</tr>
<tr>
<td>14</td>
<td>Changing the display options</td>
<td>89</td>
</tr>
<tr>
<td>15</td>
<td>Exporting fact maps</td>
<td>90</td>
</tr>
<tr>
<td>16</td>
<td>Creating fact maps</td>
<td>91</td>
</tr>
<tr>
<td>17</td>
<td>Adding text facts</td>
<td>92</td>
</tr>
<tr>
<td>18</td>
<td>Adding images</td>
<td>93</td>
</tr>
<tr>
<td>19</td>
<td>Changing fact details and properties</td>
<td>94</td>
</tr>
<tr>
<td>20</td>
<td>Exporting facts from the Fact Folder</td>
<td>94</td>
</tr>
<tr>
<td>21</td>
<td>Working with the Fact Mapper</td>
<td>95</td>
</tr>
<tr>
<td>22</td>
<td>Creating fact maps</td>
<td>96</td>
</tr>
<tr>
<td>23</td>
<td>Adding notes to facts</td>
<td>97</td>
</tr>
<tr>
<td>24</td>
<td>Using the Image Library</td>
<td>98</td>
</tr>
<tr>
<td>25</td>
<td>Adding your own images</td>
<td>99</td>
</tr>
<tr>
<td>26</td>
<td>Linking facts</td>
<td>100</td>
</tr>
<tr>
<td>27</td>
<td>Changing how a fact map is displayed</td>
<td>101</td>
</tr>
<tr>
<td>28</td>
<td>Brainstorming</td>
<td>102</td>
</tr>
<tr>
<td>29</td>
<td>Exporting fact maps</td>
<td>103</td>
</tr>
<tr>
<td>30</td>
<td>Printing, saving and opening fact maps</td>
<td>104</td>
</tr>
<tr>
<td>31</td>
<td>Evaluating calculations within documents</td>
<td>105</td>
</tr>
<tr>
<td>32</td>
<td>Scanning to HTML</td>
<td>106</td>
</tr>
<tr>
<td>33</td>
<td>Scanning from a digital camera</td>
<td>107</td>
</tr>
<tr>
<td>34</td>
<td>Scanning from a file</td>
<td>108</td>
</tr>
<tr>
<td>35</td>
<td>Scanning single pages</td>
<td>109</td>
</tr>
<tr>
<td>36</td>
<td>Scanning multiple documents</td>
<td>110</td>
</tr>
<tr>
<td>37</td>
<td>Scanning from a file</td>
<td>111</td>
</tr>
</tbody>
</table>
Exercise 3  Correcting text using the Speech Input facility.................................111
Exercise 4  Adding words to the Speech Dictionary.........................................112

24. Using the Translator Facility .............................................................................115
   Exercise 1  Translating single English words into another language ...............115
   Exercise 2  Configuring the Single Word Translation facility........................116
   Exercise 3  Translating paragraphs of text into another language....................117
   Exercise 4  Configuring the Paragraph Translation facility............................118

25. Using Study Skills ............................................................................................120
   Exercise 1  Collecting text for your studies......................................................120

26. Vocabulary .......................................................................................................122
   Exercise 1  Creating a vocabulary list for your studies....................................122

27. Creating a Word Cloud .....................................................................................124
   Exercise 1  Creating a Word Cloud from your own text.................................124
   Exercise 2  Creating a Word Cloud from a word bank....................................125
   Exercise 3  Altering the Word Cloud options....................................................126

28. Using a Voice Note ...........................................................................................128
   Exercise 1  Adding a Voice Note to MS Word ..................................................128

29. Saving and Loading Your Settings ..................................................................129
   Exercise 1  Save your personal settings.............................................................129
   Exercise 2  Load your personal settings .............................................................129
1. Introduction

Read&Write 11.5 Gold is designed to provide help to computer users with reading and writing difficulties. It can read text aloud and help construct words and sentences. It also has many other features, such as advanced spell checking, document scanning and Internet tools, to name but a few.

This guide is designed to familiarise you with all aspects of the system. As well as learning how to use the many facilities offered in Read&Write 11.5 Gold, you will also learn how to set up the system so that it will operate in exactly the way you want it to.

The exercises are colour coded and divided into:

- **Basic Exercises** – these exercises will help you learn all of the basic skills you need to set up and use the different Read&Write 11.5 Gold facilities.

- **Further Exercises** – these exercises will show additional functions that can be used.
2. **Getting Started**

In this section you will learn how to:

- start Read&Write Gold
- position the Read&Write 11.5 Gold toolbar
- understand the buttons on the Read&Write 11.5 Gold toolbar
- customise the toolbar
- change the colour of the toolbar.

**Exercise 1  Starting Read&Write 11.5 Gold**

1. In Windows 8 click on the **Read&Write 11** shortcut to start the software:

2. In other Windows versions double click on the **Read&Write 11** shortcut on your Desktop:

   The software will start.

3. If there isn't a shortcut on your Desktop, click on **Start**. Select **All Programs**, **Texthelp Systems**, **Read And Write 11**, then **Read&Write 11**.

   If you are using Read&Write 11.5 Mobile you will need to open the USB folder and double click on **RWMobile**.

   Depending on how the software is installed one of the following will happen:

   a) The Read&Write 11.5 Gold toolbar will appear – move on to **Exercise 2 – Positioning the Toolbar**.
   
   b) The User setup wizard will appear:

   This wizard will help you set how you want Read&Write 11.5 Gold to work for you. Follow each step in the wizard. When you click on **Finish** the Read&Write 11.5 Gold toolbar will appear - move on to **Exercise 2 - Positioning the Toolbar**.
c) The Texthelp Login window will appear:

Make sure that **All Users** is selected from the **User Group** drop down list and select your name in the **Login Name** drop down list. Click on **Login**. After a few seconds you will see the Read&Write 11.5 Gold toolbar appear.

### Exercise 2  Positioning the toolbar

You can position the toolbar anywhere on the screen. You can also dock it at the top or side of the screen so that it stays in one place.

1. Click on the title bar of the toolbar and then drag and drop it onto any position on your screen.

2. Click on the title bar of the toolbar again and then drag and drop it onto the very top of your screen.

3. The toolbar is docked at the top of your screen. This is where most people choose to keep the toolbar.

4. If you want to undock the toolbar, click on the button. You can also drag and drop the toolbar to either side if you wish to dock the toolbar to the side of the screen.

### Exercise 3  Understanding the toolbar

1. Hover your mouse over the green checkmark. You will see the tooltip ‘Spell Check’. Hover your mouse over the blue book button. You will see the tooltip ‘Dictionary’. From now on, if you have difficulty remembering what a button does, hover your mouse over it to see the tooltip.

2. The following table explains what each button on the toolbar does. **You will not be able to see all of the buttons listed in the table.** Simply hover over each icon you can see.
3. Click on the ![right][1] to the right of the ![right][2] button. You will see a drop down list with a number of options that allow you to setup up how you want the Spell Check facility to work.

Anytime you want to set up a facility to suit your needs, you click on the ![right][2] drop down list beside the appropriate button on the toolbar.

In future, anytime this guide asks you to click on the facility drop down list, for example, the ![right][2] drop down list, you must click on the ![right][2] button beside the appropriate button.
4. Click on the button repeatedly and notice how the toolbar changes between each of the six available toolbars. You will see a notification tooltip displayed below the toolbar. This tells you which toolbar you have just selected:

The six toolbars are:

- All Features – all buttons on the toolbar are visible
- Reading Features – only buttons associated with reading are displayed on the toolbar
- Writing Features – only buttons associated with writing are displayed on the toolbar
- Research Features – only buttons associated with researching are displayed on the toolbar
- My Features – the buttons for all the main features in the software are displayed on the toolbar
- Study Skills Features – only buttons associated with Study Skills are displayed on the toolbar.

At times there may not be enough room on the screen for all the buttons on the toolbar. When this happens click on the button that appears. This will display the other buttons on the toolbar.

If you cannot see the button you will need to use, click on the or the button until it appears.

**What else can you do:**

- Change how the buttons look - Setting up toolbar display options
- Change the colour of the toolbar – Changing the toolbar colour.
Further Exercises

Exercise 4  Setting up toolbar display options

1. Make sure the My Features toolbar is displayed. If you are not sure you have the My Features toolbar on, hover your mouse over the button on the toolbar. The tooltip tells you which toolbar it is. If it is not the My Features toolbar, click on the button. A notification tooltip will be displayed below the toolbar. This tells you which toolbar you have just selected. Keep clicking until the My Features toolbar appears:

2. Click on the drop down list again and select General Options. You will see the Display tab of the General Options window:

3. To remove some buttons from the toolbar de-select the following check boxes in the Toolbar buttons list:
   - Prediction
   - Picture Dictionary.
   Notice how the Prediction and Picture Dictionary disappear from the toolbar.

4. Select the check boxes beside the Prediction and Picture Dictionary so that they return to the toolbar.
5. Select the **Small icons with text** radio button.

   Notice how the buttons change so they are smaller and the names appear below them. Choose from the other options until you find one you prefer.

6. Select the **Clear Style Color** option from the **Select an icon set** drop down list.

   Notice how the buttons change in appearance. Try the other options until you are happy with the appearance of the toolbar.

7. When you are happy with the options click on **OK** to close the General Options panel.

**Exercise 5  Changing the toolbar colour**

You can change the background colour of the toolbar.

1. Click on the drop down list and hover your mouse over **Change Toolbar Color**.

2. You will see the Toolbar Colour options:

   ![Change Toolbar Color list]

3. Select the colour you wish to use.

4. The toolbar will change to which ever colour you have chosen.
### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to start Read&amp;Write Gold.</td>
<td></td>
</tr>
<tr>
<td>How to position the Read&amp;Write 11.5 Gold toolbar.</td>
<td></td>
</tr>
<tr>
<td>What the buttons on the Read&amp;Write 11.5 Gold toolbar are.</td>
<td></td>
</tr>
<tr>
<td>How to customise the buttons on the toolbar.</td>
<td></td>
</tr>
<tr>
<td>How to change the colour of the toolbar.</td>
<td></td>
</tr>
</tbody>
</table>
3. Reading

In this section you will learn how to:

- have text read in documents
- change the voice
- specify how you would like words pronounced
- instruct the system to read letters, words and sentences as you type
- set up Screen Reading
- set up speech highlighting and use the speech buttons.

Exercise 1  Reading text in documents

Open a Word document with some text in it or type the following text into a blank Microsoft Word document:

A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases. An example of a volcano is Mount Rinjani. This volcano is found on the island of Lombok. It has a long history of eruptions and erupted in 1994 and more recently in May 2010. Volcanoes can cause major destruction.

It is recommended that you save this document as you will use it later in the guide.

Remember to check that your sound is enabled!

1. Place the cursor anywhere in the text and then click on the button on the toolbar to hear the text read aloud.

2. Click on the button to stop the reading.
Exercise 2  Changing the voice

If you are not happy with the voice that is used to read the text you can change it. To do this:

1. Click on the drop down list on the toolbar and select Speech Options.

   You will see the Speech tab of the Speech Options window:

   ![Speech Options window](image)

   - Select a voice drop down list
   - Search button
   - Pitch track bar
   - Speed track bar
   - Volume track bar
   - Test voice button

2. Select a different voice from the Select a voice drop down list.

3. Click on the Test voice button to hear the new voice read aloud. If you don't like the voice select another.

4. You can change the Pitch, Speed and Volume of the voice if you need to by dragging and dropping the track bars.

   Notice that the Use arrow keys to change speed check box is selected. This will allow you to use the Up (↑) and Down (↓) keys on your keyboard to change the voice speed when it is reading.

5. When you are happy with the voice click on the OK button.

Other voices can be downloaded from the Read&Write Essentials website.

What else can you do:

- Change how words are pronounced – Changing how words are pronounced.
- Have the text read as you type – Instructing the system to read as you type.
- Have the software read buttons and menus – Setting up screen reading.
- Change how the text is highlighted – Changing the speech highlighting.
Further Exercises

Exercise 3  Changing how words are pronounced

There may be occasions when the software does not pronounce a word correctly. In this exercise you will learn how to correct the pronunciation of a word.

1. Click on the 📻 drop down list on the toolbar and select Speech Options.

   You will see the Speech tab of the Speech Options window. Click on the Say Like tab:

2. Type the word Angeline into the Pronounce this text box and then click on the 🎧 button beside the text box to hear this word read aloud. Currently it is not being pronounced correctly.

3. Type Angjalene into the Like this text box and then click on the 🎧 button beside the text box to hear the new pronunciation read aloud. This is the correct pronunciation of the word.

4. Click on the Save button. This will add the word to the Pronunciation list. Now that it is added the word will be pronounced correctly.

5. Click on the OK button to close the Speech Options window.
Exercise 4  **Instructing the system to speak as you type**

You may want to have the software read as you are typing. In this exercise you will learn how to set up the system to read letters, words and sentences as you type.

1. Click on the drop down list on the toolbar and select **Speech Options**.

You will see the Speech tab of the Speech Options window. Click on the Autoread tab:

2. Select the **I would like to use speak as I type** check box and then select from:
   - **Speak on each letter** check box.
   - **Speak on each word** check box
   - **Speak on each sentence** check box.

3. Click on the **OK** button to save the settings and to close the Speech Options window.

4. Place your cursor after the text you have already typed and type some text slowly. As you do so, the text will be read aloud.

5. If you wish to turn this option off. Click on the drop down list on the toolbar and de-select the **Speak As I Type** option to stop the system from reading as you type. This is a shortcut to turning this option on or off.
Exercise 5  

**Setting up Screen Reading**

You may have problems reading icons or menus. In this exercise you will learn how to set up the system to read menu options and button labels.

1. Click on the drop down list on the toolbar and select **Speech Options**.

   You will see the Speech tab of the Speech Options window displayed. Click on the Auto Read tab:

   ![Speech Options window](image)

   - **I would like to use screen reading** check box
   - **Screen reading** check boxes

2. Select the **I would like to use screen reading** check box. Then click **OK**.

3. The Speech Options will close.

4. Hover your mouse over the **Play** button on the toolbar. You will hear the system say ‘Play’.

5. Click on the drop down list and hover your mouse over **Read by word** and then **Read by sentence**. You will hear each menu option read aloud.

6. If you wish to turn this option off click on the drop down list and de-select the **Use Screen Reading** option. This is a short cut to turning the feature on or off.
Exercise 6  **Changing the speech highlighting**

The system highlights the text in the document as it is being read. It uses the colours blue and yellow. You may wish to change this. In this exercise you will learn how to alter how text is highlighted as it is read including the colours used and/or how it is displayed.

1. Click on the drop down list on the toolbar and select **Speech Options**.

   You will see the Speech tab of the Speech Options window displayed. Click on the Highlight tab:

2. To change the colour that is used for highlighting the text as it is read click on the **Choose the highlighting colors** dropdown menu and select from the list. A preview will appear in the Options section.

3. Click **OK** to close the Speech Options.

4. Click in to the text you wish to have read and then the button. The text will be highlighted using the colours you have chosen.

5. To change the speech highlighting method, return to the Speech Options Highlighting tab. There is the choice of:

   - **Speak with highlighting in document** radio button. This is the one you have been using.

   - **Speak with highlighting in Text Reader** radio button.

   - **Speak using one word display** radio button.

   - **Speak with no visual display** radio button.

6. Select the **Speak with highlighting in Text Reader** radio button.
7. Click on the **Font size** dropdown and select 38 and then click on the **Choose the highlighting colors** dropdown and select one of the options.

8. Place your cursor anywhere in the text in your document and then click on the button. You will see the sentence displayed in a popup window as it is read aloud. The font size will be 38 and it will be highlighted using the colours you chose.

9. Open the Highlight tab of the Speech Options window again and try one of the other options.

The other highlighting options are as follows:

- **Speak using one word display** radio button. This will read the text and display each individual word in a panel.

- **Speak with no visual display** radio button. This will read the text without any visual display or colour.

10. Before finishing this exercise make sure you turn the highlighting method back to **Speak with highlighting in document**.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>☑</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to have a document read.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to change the voice.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to change the pronunciation.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to have the software read as I type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to have the software read icons or menus.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to change how the software highlights text as it is being read.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4. **Reading Webpages**

In this section you will learn how to:

- read webpages in Internet Explorer
- read webpages in FireFox
- read webpages in Chrome.

**Exercise 1  ** *Reading webpages in Internet Explorer*

1. Click on the drop down list on the toolbar and look at the **Read the web** option. If this option is already switched on you will see a tick beside it:

   ![Read the web option](image)

2. If it is turned off it will look at this:

   ![Read the web option](image)

   To turn it on, hover your mouse over the **Read the web** option and click on it.

3. Open a website e.g. [www.texthelp.com](http://www.texthelp.com).

4. Hover your mouse over an area of text until you see it highlighted. You will hear the text read aloud.

5. Move your mouse to another area of text until you see it highlighted. You will again hear the text read aloud. Read&Write 11.5 Gold will read aloud any of the text that is under your mouse.

6. To switch the **Read the web** option off click on the drop down list on the toolbar and click on the **Read the web** option.

**Exercise 2  ** *Reading webpages in Firefox*

1. Open your Firefox browser.

2. Click on **Yes** when prompted to install the plug-in.

3. After the plug-in has been installed follow Exercise 1 above.

**Exercise 3  ** *Reading webpages in Chrome*

1. Open Google Chrome.

2. Click on **Install Now** when prompted to install.

3. Click on **Add**.

4. Restart Chrome.

5. After the extension has been installed follow Exercise 1 above.
<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to have a webpage read in Internet Explorer.</td>
<td></td>
</tr>
<tr>
<td>How to have a webpage read in Firefox.</td>
<td></td>
</tr>
<tr>
<td>How to have a webpage read in Chrome.</td>
<td></td>
</tr>
</tbody>
</table>
5. **Reading Inaccessible Text**

In this section you will learn how to:

- use the Screenshot Reader
- change the options in the Screenshot Reader.

In most cases simply using the button or the Read the web option will enable the text in a document or webpage to be read to you. However there are some programs where the text is inaccessible. For example: inaccessible Flash, locked PDF documents and text in images. When you want to have text read in these applications you will need to use the Screenshot Reader.

**Exercise 1  Using the Screenshot Reader**

1. Open the Texthelp webpage [www.texthelp.com/uk/training-screenshot](http://www.texthelp.com/uk/training-screenshot) in your Internet browser window.

2. Click on the button. Your cursor now looks like this: .

3. Click and hold your left mouse button on the top left-hand corner of the picture, then drag and drop the rectangle to the bottom right-hand corner.

   Read&Write 11.5 Gold reads the text aloud:

   ![Text]

   If you wish the text to be re-read click on the button.

4. Click on the button to close the Screenshot Reader window.
Exercise 2  **Screenshot to MS Word**

If you wish you can have the text that the Screenshot Reader finds put directly into Microsoft Word. Once in Microsoft Word you will be able to edit it and use the button to have it read.

1. Click on the drop down list and select **Screenshot to MS Word**.

2. Click on the button. Your cursor now looks like this: 🖼️.

3. Select the area again.

   If you already have a Microsoft Word document open the text is displayed at the end of it. If you don't have a Word document open the Screenshot Reader will create one for you and put the text in.

4. Click on the button to read the text aloud.

   You can also use the other Read&Write 11.5 Gold facilities on the text imported into Microsoft Word.

5. Close the Microsoft Word document when you have finished.

6. Click on the drop down list and click on **Screenshot to MS Word** to turn this off.

**What else can you do:**

- Change the Screenshot Reader options – [Changing the Screenshot Reader options](#)
Further Exercises

Exercise 3  Changing the Screenshot Reader options

You can change how the text is highlighted by the Screenshot Reader. You can also alter how you capture the area that you want to use the Screenshot Reader with.

1. Click on the drop down list and select Screenshot Reading Options.

You will see the Screenshot Reader Options window displayed:

![Screenshot Reader Options window]

2. Select the **Use outline highlighting** radio button.

3. Select **Green** from the **Outline color** drop down list.

4. Select **5** from the **Outline weight** drop down list.

5. Click on the **OK** button.

6. Click on the button. Your cursor now looks like this: 

![Cursor with outline highlighting]

7. Select the area again. Read&Write 11.5 Gold reads the text aloud using the settings you have just selected.

8. Click on the button to close the Screenshot Reader window.

9. Click on the drop down list. There is the option to choose a different capture method:
   - **Capture by drawing rectangle** – this is the usual method of capture
   - **Capture by hover** – this will capture an area highlighted
• Capture by drawing freehand – this is useful if the text is in a strange shape.

10. Select **Capture by drawing freehand**.

11. Click on the button. Your cursor now looks like this: ![Cursor Image].

12. Select the area again, but this time draw around it using the cursor.

   Read&Write 11.5 Gold reads the text aloud using the settings you have just selected.

13. Click on the button to close the Screenshot Reader window.

14. Click on the drop down list and select **Screenshot Reader Options**.

   ![Screenshot Reader Options Window]

   Use outline highlighting radio button

15. Notice that the **Append to active Microsoft Word document** check box is selected. This means that any screenshot to MS Word that you take will automatically be put at the end of the Word document that you are using. This is important if you want to have all the screenshots put into the same document.

16. Notice that the option to **Automatically close after reading** is switched off. This is why the box stays around the text you have selected and you have the option to use the button to have it read again.
<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to screenshot in the window.</td>
<td></td>
</tr>
<tr>
<td>How to screenshot to MS Word.</td>
<td></td>
</tr>
<tr>
<td>How to change the capture method.</td>
<td></td>
</tr>
<tr>
<td>How to change the highlighting colours.</td>
<td></td>
</tr>
<tr>
<td>How to append the screenshot to an existing document.</td>
<td></td>
</tr>
<tr>
<td>How to have the screenshot automatically close after reading.</td>
<td></td>
</tr>
</tbody>
</table>
6. Converting Text into Sound Files

In this section you will learn how to:

- convert text into a sound file.

It is possible to convert your text into a sound file using Read&Write 11.5 Gold. Once converted the sound file can be put onto an audio device such as an iPod, MP3 player or smart phone and listened to when and where you wish.

Exercise 1 Converting text into sound files

1. Highlight the following text in your document:

   A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases. An example of a volcano is Mount Rinjani. This volcano is found on the island of Lombok. It has a long history of eruptions and erupted in 1994 and more recently in May 2010. Volcanoes can cause major destruction.

2. Click on the button on the toolbar.

   The highlighted text is displayed in the first window of the Speech Maker facility:

3. Click on the Next button. You will see the second window in the Speech Maker facility:

   ![Text window showing the highlighted text]

   You can type into this window if you wish to add further text.

   ![Second window of Speech Maker facility]
4. Select one of the voices from the **Selected Voice** drop down list and then drag and drop the following track bars:

   - **Speed** – drag this track bar to the left to slow the voice down.
   - **Volume** – drag this track bar to the left to decrease the volume or to the right to increase the volume.

5. Click on the **Test voice** button to hear what the voice will sound like. If you decide that you don't like this voice, select another one from the **Selected Voice** drop down list and adjust the track bars until you are happy.

6. Once you have selected a suitable voice, click on the **Next** button.

   You will see the third window in the Speech Maker facility:

7. Click on the **Browse** button to display the Save As window.
8. Browse to the folder in the directory in which you want to save the sound file, type a name for the file in the **File name** text box, and then click on the **Save** button.

9. The **MP3** sound file format radio button is selected by default as this is the most popular format. This format is supported by most audio players such as MP3 players, iPods, etc.

10. Click on the **Create** button to create the sound file.

11. Browse to the directory where you saved the sound file and open it to hear the sound file you have just created. You hear the text you highlighted in step 1 read aloud.

Now you will be able to put the sound file on to which ever audio player you wish.

12. Once you have used the Speech Maker you can turn on a shortcut to reduce the steps. Click on the **Create file using last saved settings** drop down list on the toolbar and select **Create file using last saved settings**. Now when you select text and click on the **Create** button, you will see the Save As window and you will just have to give the file a name and click on **Create**.

13. If you wish to turn off this shortcut click on the **Create file using last saved settings** drop down list on the toolbar and make sure **Create file using last saved settings** is de-selected.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to convert text into an audio file.</td>
<td></td>
</tr>
</tbody>
</table>
7. Reading Dragon Recognised Text

In this section you will learn how to:

- have Read&Write Gold read Dragon recognised text.

Dragon, the speech recognition software, allows you to create documents by simply talking into a microphone. Read&Write 11.5 Gold can read aloud text recognised by Dragon, which is useful if you want to make sure that Dragon has recognised exactly what you wanted to say.

Exercise 1 Reading Dragon Recognized Text

1. Make sure that Dragon is running and close all open documents.

2. Click on the drop down list on the Read&Write 11.5 Gold toolbar and select Speak Dragon Recognized text.

3. Open a new document in Dragon.

4. Speak the following into your new document:

   A volcano is a geological landform on the surface of the earth (and other planets) where magma from the planet's interior erupts (or once erupted) to the surface.

   Notice how Read&Write 11.5 Gold reads the text aloud.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to have Read&amp;Write Gold automatically read text inputted using Dragon.</td>
<td></td>
</tr>
</tbody>
</table>
8. **Working with Daisy Books**

In this section you will learn how to:

- read Daisy Books
- navigate through a Daisy Book.

**Exercise 1  Reading Daisy Books**

Before you begin this exercise, make sure you have a Daisy Book saved on your computer.

If you don't have a Daisy Book to work with, you can carry out a search on the Internet for Daisy Books.

You can open an AudioPlus book which you may have received from the RFB&D (Recordings for the Blind and Dyslexic). However, you cannot use the Read&Write 11.5 Gold toolbar to read the chapters aloud. Instead, you can use the Speech buttons at the bottom of the Daisy Reader window.

1. Click on the button on the toolbar.

   You will see the Browse For Folder window displayed.

2. Browse to the location in the directory where you have saved the Daisy file, select it and then click on the OK button.

If you are opening an AudioPlus book, you must browse to the location of your User Authorization Key, select it and then click on the Open button. You can then enter the PIN code supplied to you by the RFB&D.

The Daisy Book opens in the Daisy Reader window.

The table of contents for the book is displayed on the left-hand-side of the Daisy Reader window. Click on a page/section to view it.

3. Complete either of the following options:

   - if web highlighting is switched on, hover your mouse over the area of text you want read aloud

   - if web highlighting is not switched on, click on the button on the Read&Write 11.5 Gold toolbar.

4. Click on the Display menu and select **Display Options**. You will see the Display Options panel displayed.
5. Specify that you would like to make the font size 20 and the text bold. If you wish, change the text and background colour by clicking on the colour dropdown. Click on the Cancel button when you are happy with the settings.

6. Have some text read again and notice the difference in the settings.

Exercise 2 Navigating through a Daisy Book

In this exercise you will learn how to find the text that you want to read aloud in the Daisy Book and set up bookmarks.

1. Make sure the Daisy Book is open.

2. Click on the appropriate Navigation button to move through the pages:
   - displays the first page in the book
   - displays the previous page in the book
   - displays the next page in the book
   - displays the last page in the book.

You can insert bookmarks in the text. To do this:

3. Click on the button. You will see the Save Bookmark window displayed.

4. Type Bookmark1 in the text box provided and then click on the Save Bookmark button.

5. Go to another page in the Daisy Book and repeat steps 3 and 4 to add another bookmark, and call it Bookmark2.

6. Now practice finding the bookmarked text.

7. Select Bookmark1 from the Bookmarks drop down list and then click on the button.

You can search for words in the text. To do this:

8. Type a word that you know is in your Daisy Book, in the Find Text In Book text box, and then click on the button.

The first instance of the word or phrase is highlighted in your Daisy Book. If you want to view the next instance, click on the button again.
## Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>☑</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to read a Daisy Book</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to navigate through a Daisy Book.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
9. Using the Pronunciation Tutor

In this section you will learn how to:

- check how words are pronounced
- create syllable exceptions.

**Exercise 1  Checking how words are pronounced**

1. Click on the button on the toolbar to display the Pronunciation Tutor window:

2. Select ‘Microsoft Zira Desktop’ from the **Available Voices** drop down list.

3. Make sure the following check boxes are selected:
   - **Display Syllabification**
   - **Use the lips for pronunciation**
   - **Advanced Display**
   - **Display Phonetic Letters**
   - **Display Phoneme Equivalent**.

4. Type **volcano** into the **Selected word** text box and then click on the **Speak** button.

   Note how the lips and tongue move to show you how to form the word with your mouth. Also note how the word ‘volcano’ is broken down into three syllables in the **Display Syllabification** text box.

5. Double click on the letter **v** in the **Display Phoneme Equivalent** text box. The Phoneme Information section is populated with information, e.g. words that are also pronounced using the ‘V’ sound used in ‘volcano’ are listed in the **Example Words** text boxes.
6. Click on the button to close the Pronunciation Tutor.

**What else can you do:**

- Create syllable exceptions where the pronunciation is not correct – Creating syllable exceptions.

**Further Exercises**

**Exercise 2  Creating syllable exceptions**

In this exercise you will learn how to teach the system to pronounce the word ‘hungry’ differently.

1. Type the word **hungry** into your document, highlight it and then click on the button. Notice how the Pronunciation Tutor breaks the word into the syllables ‘hun’ and ‘gry’.

2. Click on the Syllable Exceptions tab:

3. Click on the New button.

4. Type **hungry** into the **Target Word** text box and then type **hung-ry** into the **Modified Syllables** text box.

5. Click on the **Speak** button to hear the new pronunciation read aloud and then click on the **Save** button to add it to the **Syllable Exceptions** list box.

6. Click on the button to close the Pronunciation Tutor window.
Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to check how words are pronounced.</td>
<td></td>
</tr>
<tr>
<td>How to create syllable exceptions.</td>
<td></td>
</tr>
</tbody>
</table>
10. Reading PDF Documents

In this section you will learn how to:

- read a PDF file using PDF Aloud.
- using PDF Aloud in Adobe.

PDF Aloud is designed to provide help to Adobe Acrobat users with reading difficulties. It does this by reading text aloud from PDF documents.

Exercise 1  Reading PDF documents

In this exercise you will learn how to read text aloud from PDF documents using PDF Aloud. You will also learn how to choose the colours for use during the reading of text aloud using the Preferences in Read&Write.

1. Click on the button and then open a PDF document.
2. The PDF document will open and look something like this:

3. Click on the button on the Read&Write toolbar. PDF Aloud reads aloud the text in your document.

   To just have part of the text read, select the text and click .

4. Click on the button on the Read&Write Gold for toolbar to stop the reading.
5. Across the top of the window is a toolbar:

   6. The Table of Contents when clicked will show the contents of the PDF.
   7. The Current Page shows you what page you are on. You can change the page using the Previous Page and Next Page arrows.
8. Click on + to zoom in to your document.
9. Click on - to zoom out of your document.
10. The Click to Speak is active if the circle next to the hand is green. This means you can click somewhere specific in the document to have it read aloud.

Exercise 2  Reading a PDF file in Adobe using PDF Aloud

1. Open a PDF document in Adobe Reader 10, 11 or Adobe Acrobat 11.
2. The PDF is displayed in Adobe. However, to view the PDF Aloud toolbar, you must click on Tools on the toolbar and select Plug-In PDFaloud. The PDF Aloud toolbar is displayed:

3. Click on the button. PDF Aloud starts to read aloud the document.
4. Click on the button to stop the system from reading the document.

⚠️ If you cannot see the PDFaloud plug-in under Tools you may have a different version of Adobe Reader. If there is an Extended option check for PDFaloud plug-in here.

What else can you do:

- Change how PDF Aloud reads – Altering the PDF Aloud options.
Further Exercises

Exercise 3  Altering the PDF Aloud options

1. Click on the **Click and Speak** button then anywhere in the text that you wish read.

   With **Click and Speak** switched on you just need to click where you want it to read.

2. To turn off **Click and Speak** click on the **Click and Speak** button again.

3. You can choose how much text is read at a time by choosing from:
   - ![Read by word](image)
   - ![Read by sentence](image)
   - ![Read by paragraph](image)

4. Click on the **Options** button on the toolbar. PDF Aloud is set to have Continuous Reading. You will know it has been selected if you see a tick beside it, as shown below:

   ![Continuous reading](image)

   With this switched on when you start PDF Aloud to read it will continue to read the whole document.

5. You can turn off the Continuous Reading by de-selecting it.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to have a PDF document read using PDF Aloud.</td>
<td></td>
</tr>
<tr>
<td>How to have a PDF document read in Adobe using PDF Aloud.</td>
<td></td>
</tr>
<tr>
<td>How to alter how PDF Aloud reads.</td>
<td></td>
</tr>
</tbody>
</table>
11. Spell Checking

In this section you will learn how to:

- use the Spell Checker
- spell check as you type
- change the spelling settings
- use the Auto Correct file
- add words to the Custom Spelling Dictionary
- review spellings suggestions
- add a phonetic replacement
- review the log of spelling errors.

Type the following text into a blank Microsoft Word document:

There are deliberate spelling mistakes in the text that you must enter letter for letter. They are underlined. You do not need to underline these mis-spelt words in your document.

A volcano tends to occur where tectronic plates meet. The earth is made up of about 8 big tectronic plates. When volcanoes erupt they can throw out lava, ash and gases. An example of a volcano is Mount Rinjani. This volcano is found on the island of Lombok. It has a long history of eraptions and erupted in 1994 and more recently in May 2010.

Exercise 1  Using the Spell Checker

1. Click on the button on the toolbar. You will see the Spelling Helper window displayed:

The first mis-spelt word in your document is highlighted in red.

You can use the following buttons to correct your spellings:
• **Change** button – select a word from the **Word** list box and then click on this button to change the mis-spelt word to the selected word. **Use this to correct** ‘volcaneo’ to ‘volcano’.

• **Change all** button – select a word from the **Word** list box and then click on this button to change all instances of the mis-spelt word throughout your document. **Use this to correct** ‘tectronic’ to ‘tectonic’.

• **Add custom** button – click on this button to add the selected word to your Custom Spelling Dictionary. **Use this to add** ‘Rinjani’ **to the Custom Dictionary**.

• **Auto Correct** button – select a word from the **Word** list box and then click on this button to add the mis-spelt word to the auto correct file. In future, when you type the word incorrectly, the Spelling facility will now automatically change the word to the selected word. **Use this to correct** ‘iland’.

  **Correct the rest of the document.**

• **Ignore** button – click on this button to ignore the mis-spelt word.

The Spelling Helper window closes as soon as the spell check is complete.

**What else can you do:**

• Spell check as you type – **Using Spell as I Type**.
• Add words to the Custom Dictionary – **Adding words to the Custom Spelling Dictionary**.
• Alter how the spelling works – **Changing the spelling settings**.
• Have spelling mistakes automatically corrected – **Using the Auto Correct**.
• Review the spelling suggestions that have been provided – **Reviewing spellings**.
• Alter the spelling suggestions – **Adding a phonetic replacement**.
• View your spelling log which records all the spelling mistakes you have made - **View your spelling log**.
Further Exercises

Exercise 2  Using Spell as I Type

You can have the Spell Check help you correct your document as you are typing. To do this:

1. Click on the ✓ drop down list on the toolbar and select Spell As I Type.

Type the following text into a blank Microsoft Word document:

There are deliberate spelling mistakes in the text that you must enter letter for letter. They are underlined. You do not need to underline these mis-spelt words in your document.

A volcaneo tends to occur where tectronic plates meet.

2. As soon as you type ‘volcaneo’ the Spelling Helper panel appears. You can use this to correct ‘volcaneo’ to ‘volcano’

3. As soon as you type ‘tectronic’ the Spelling Helper panel appears again. You can use this to correct ‘tectronic’ to ‘tectonic’.

4. Click on the ✓ drop down list on the toolbar and de-select Spell As I Type to disable this facility.
Exercise 3   Adding words to the Custom Spelling Dictionary

In this exercise you will learn how to add words that the spell checker does not recognise to the Custom Spelling Dictionary. (Once you have added a word, the spell checker will no longer identify it as a mis-spelt word.) These tend to be names of people or places.

To add words to the Custom Spelling Dictionary:

1. Click on the drop down list on the toolbar and select Spelling Options.

You will see the Custom tab of the Spelling Options window:

2. Notice that the word Rinjani is in here. This was added in the last exercise.

3. Type the word Bannack in the New word text box. Bannack is the name of a town and isn’t recognised as being a correct word.

4. Click on the Add word button. ‘Bannack’ is added to the Custom spelling dictionary list box.

5. Click on the OK button to save the settings and to close the Spelling Options window.

6. This means from now on if you should ever type Bannack the Spell checker will recognise it is a correct word. You can add further words in to the Custom Dictionary in the same way if you need to.
Exercise 4  Changing the Spelling settings

You can change what spelling mistakes the Spell Checker looks for, the search methods and the vocabulary that it checks words against.

1. Click on the green check mark drop down list on the toolbar and select Spelling Options.

You will see the Custom tab of the Spelling Options window. Click on the Settings tab:

2. Select the Ignore domain names (e.g. www.TextHelp.com) check box in the Ignore list section. This means that when you use the spell checker it will ignore website addresses.

3. Notice that all of the check boxes in the Your search methods section are selected to specify that you want the Spell Checker to search for all possible types of mistakes.

4. Select Science, Medical and Biology in the Vocabulary section. This will add these types of vocabulary to the spellchecker. You would particular want to add these if you commonly use these types of words.

5. Click on the OK button to save your settings and to close the Spelling Options window.
Exercise 5  Using the Auto Correct file

In this exercise you will learn how to configure the Spell Checker to automatically correct commonly mis-spelt words.

1. Click on the drop down list on the toolbar and select **Spelling Options**.

You will see the Custom tab of the Spelling Options window displayed.

Make sure the **Advanced options** check box in the bottom left-hand corner is selected and then click on the Automatic tab:

You will see a list of words in the **Automatic corrections** list box – if you completed Exercise 1 you will see the word 'iland' here. The words listed will be automatically changed to the correct spelling if you accidentally type them when creating future documents.

2. Make sure the **Use automatic corrections to replace the text as you type** check box is selected.

3. Click on the **New** button.

4. Type ‘**distruction**’ in the **Common Error** text box and then type ‘**destruction**’ in the **Correction** text box. Click on the **Save** button to add it to the list.

5. Click on the **OK** button to save the new settings and to close the Spelling Options window.

6. Type the following text into your document:

   There is a deliberate spelling mistake in the text that you must enter letter for letter. It is underlined. You do not need to underline this mis-spelt word in your document.

   **Volcanoes can cause major destruction.**
Notice how the Spell Checker automatically corrects the mis-spelt word you have just added to the Auto Correct file earlier in this exercise, i.e. ‘destruction’.

**Exercise 6  Reviewing spellings**
You can review what suggestions the spell checker has provided. To do this:

1. Click on the drop down list on the toolbar and select **Spelling Options**. You will see the Custom tab of the Spelling Options window displayed.

   Make sure the **Advanced options** check box in the bottom left-hand corner is selected and then click on the History tab:

   ![Spelling Options window](image)

   - **Recent errors** list box
   - **Advanced options** check box
   - **Suggestions** column
   - **Error type** column

2. Select ‘volcaneo’ from the **Recent errors** list box. You will see a list of possible corrections and the error types in the **Suggestion** and **Error type** columns.

3. Click on **OK** to close the Spelling Options.

**Exercise 7  Adding a phonetic replacement**
The Spell Check facility uses a phonetic map to make suggestions for mis-spelt words. Phonetic maps help the Spell Checker to find corrections for difficult spelling errors such as phonetic errors and errors caused by OCR. It uses groups of letters that sound the same or are normally confused.

For example, if you often type ‘telefone’ or ‘elefant’, Read&Write 11.5 Gold will be able to use the phonetic mapping ‘f = ph’ to solve these errors.

Read&Write 11.5 Gold can also solve spelling errors where there are many phonetic errors in one word. For example, if you type ‘nolij’, Read&Write 11.5 Gold uses the phonetic mappings ‘no = know’ and ‘ij = edge’ to solve the error and suggest ‘knowledge’.

1. Type the letters **noledge** into your document.
2. Highlight the word you have just typed and then click on the ✓ button on the toolbar.

3. You will see the Spelling Helper window displayed. Note that the Spelling facility has suggested the word ‘knowledge’ as a replacement.

4. Click on the ✗ button on the top right-hand corner of the Spelling Helper window to close it.

5. Click on the ✓ drop down list on the toolbar and select Spelling Options. You will see the Custom tab of the Spelling Options window displayed.

6. Make sure the Advanced options check box in the bottom left-hand corner is selected and then click on the Phonetics tab:

![Phonetic Options Window]

The phonetic replacements already present on the phonetic map are listed in the Phonetic map list box.

7. Find the phonetic replacement for ‘no=know’ in the Phonetic map list box. When you typed the word ‘noledge’ in step 1, the Spelling facility was able to use this phonetic replacement to suggest the word ‘knowledge’ as a replacement word.

8. You can add new phonetic replacements if needed.

9. Click on the OK button to close the Spelling Options window.
Exercise 8  View your spelling log

When you use the Spell Checker it will keep a record of all the spelling mistakes made and the corrections. To open the Spelling Log:

1. Click on the drop down list on the toolbar and select Spelling Options. You will see the Custom tab of the Spelling Options window displayed.

2. Make sure the Advanced options check box in the bottom left-hand corner is selected and then click on the Log tab:

You can see a record of all the words you have mis-spelt.

If you see a spelling error that you would like the Spelling facility to automatically change to the correction listed in the Log tab, click on the correction and then click on the Auto add button to add it to the Auto Correct file.

3. If you wish to have this log printed out click on the Print log button.

4. Click on OK to close the Spelling Options.
# Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>☑</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to spell check a document.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to use spell as I type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to add words to the Custom Dictionary.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to set the spelling settings.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to use the auto correct.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to review the spelling suggestions.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to add a phonetic replacement.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to view the spelling log.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
12. Predicting Text

In this section you will learn how to:

- use the Prediction facility
- teach the Prediction new vocabulary
- download prediction word banks
- change the appearance and behaviour of the Prediction window
- set up prediction speech options
- learn vocabulary patterns
- set up phonetic replacements
- set the context level
- add additional word banks
- add individual words to the prediction.

Exercise 1 Using Prediction

In this exercise you will learn how to use Prediction to help you finish sentences. It will access a list of words that will complete the one that you are currently typing and will also try to predict your next word as you finish typing a word.

1. Open a new blank document in Microsoft Word and then click on the button on the toolbar to display the Prediction window.

2. Type the following text into your document and notice how the Prediction window is predicting words for you to use:

   This is an ex

3. When you type in the ‘ex’ you will see a list of words beginning with ‘ex’ displayed in the Prediction window.

4. Click on ‘example’ in the Prediction window or press the appropriate function key on your keyboard. The word is inserted into your document, followed by a space. The Prediction window will then have another list of words for you to choose from.

   There is also a useful feature that allows you to view dictionary definitions and homophones in the Prediction window.

5. Beside the list of words in the Prediction window some of them have the following symbol next to them: . This indicates that the word is a homophone or confusing word.

6. If you are unsure what a word means. Hover your mouse over it and then click on the symbol.

7. You will see the Dictionary displayed. Something like this:
8. You can read the definition in the **Dictionary meanings** list box and decide if it is the word you are looking for. Click on the button on the top right-hand corner of the Dictionary window to close it.

9. Use the Prediction to write a few sentences and watch how the Prediction provides the type of vocabulary you are likely to want to type.

10. Close Prediction by clicking on the button.

**What else can you do:**

- Add words to the prediction – [Teaching the Prediction new vocabulary patterns](#).
- Download more words to use with prediction – [Downloading prediction word banks](#).
- Change how the Prediction window looks and acts – [Changing the prediction window](#).
- Have the suggested words read for you – [Setting up prediction speech options](#).
- Learn vocabulary patterns from existing text – [Learn vocabulary patterns](#).
- Add phonetic replacements – [Setting up phonetic replacements](#).
- Set the context level – [Set the context level](#).
- Add additional word banks – [Applying prediction word banks](#).
- Adding individual words to the prediction word bank - [Adding individual words to the prediction word bank](#).
Exercise 2  Teaching the Prediction new vocabulary patterns

In this exercise you will learn how to specify exactly how you want the Prediction facility to learn vocabulary patterns to improve its predictions.

1. Type the following text into your document or select some text from one of your documents:

   A volcano is a geological landform on the surface of the earth (and other planets) where magma from the planet’s interior erupts (or once erupted) to the surface. Roughly defined, a volcano consists of a magma chamber, pipes and vents.

2. Copy the text and then click on the drop down list and select Create prediction word bank from the clipboard.

3. You will see the Create a new prediction word bank window displayed:

   ![Create a new prediction word bank window](image)

4. Type the following details:
   - File name – Volcano (if you have used your own text put in a file name relevant to it)
   - Description – Volcano definition (if you have used your own text put in a description relevant to it).

5. Click on the OK button.

   A message box is displayed. It informs you that a new prediction word bank has been created and saved in your User Setting’s folder. It is turned on and now available for use.

6. In a Word document start to type some of the words that you have just added and notice how the prediction is predicting words based on that text.
Exercise 3  **Downloading prediction word banks**

In this exercise you will learn how to teach the Prediction facility new vocabulary patterns from word banks downloaded from the Texthelp website.

You must be online in order to download prediction word banks.

1. Click on the drop down list on the toolbar and select **Download prediction word banks**.

A list of the prediction files currently available for download is displayed in the Download prediction word banks dialog box:

2. If required, you can filter this list for a specific topic. To do this, enter the topic you want to search for in the **Search for prediction word banks** text box and then click **Search**.

3. Select the check box beside one of the prediction word banks and then click **Download**.

4. When the download is shown as ‘Complete’, click on the **Close** button.

Words based on the topic you have downloaded will now be available when you use the Prediction.

Exercise 4  **Changing the Prediction window**

In this exercise you will learn how to alter the appearance and behaviour of the prediction window.

1. Click on the drop down list on the toolbar and select **Prediction Options**.

You will see the Display tab of the Prediction Options window displayed:
2. Select ‘2’ from the **Columns** drop down list and ‘6’ from the **Rows** drop down list to specify the amount of columns and rows with which you want to display the information in the Prediction window.

3. Click on the **Color** palettes and select the colours you want to use for the background, text and highlighting colours in the Prediction window. Make sure you don't pick colours that clash because this will make it hard to read.

4. Click on the **Change Font** button and select a font size of 20.

5. Select from the check boxes in the Prediction window behaviour section which you would like to turn on/off.
   - **Display words alphabetically** - instructs the system to list the words in the Prediction window alphabetically.
   - **Follow the cursor during typing** – instructs the system to have the Prediction window follow where the cursor goes.
   - **Auto height adjust** – instructs the system to have the Prediction window change size depending on the amount of words appearing.
   - **Predict one word ahead** – instructs the system to predict a word ahead.
   - **Insert a space after predictions** – instructs the system to automatically insert a space after a word when it is inserted.
   - **Display dictionary buttons** – allows you to find the definition of words suggested in the Prediction window.
   - **Indicate words that are homophones** – instructs the system to list words that are homophones in the Prediction window.

6. Click on the **OK** button.
7. Click on the button and as you start to use the prediction again you will see the changes you have made.

Exercise 5  Setting up prediction speech options
In this exercise you will learn how to get the system to read aloud words from the Prediction window.

1. Click on the drop down list on the toolbar and select Prediction Options.
2. You will see the Display tab of the Prediction Options window displayed:

3. Select the Speak the word when clicked option.
4. Click on OK.
5. Return to your Word document. Click on the button.
6. Start to type into your document. Click on a word being suggested in the Prediction window. It will be read to you.
7. Use the Function buttons to insert the word.
8. Close Prediction by clicking on the button.

This is one way of having the words read in the Prediction panel. There are 2 others:

9. Click on the drop down list on the toolbar and select Prediction Options.
   You will see the Display tab of the Prediction Options window displayed.
10. Select the Insert the word when clicked option.
11. Click on the Speech tab:
12. Select the **Speak when mouse pointer hovers over word** check box to specify that you want the Prediction facility to speak a word when you hover your mouse over it in the Prediction window.

13. Click on the **OK** button to save the settings and to close the window.

14. Click on the **button on the toolbar to display the Prediction window.

15. Start typing into your document. You will see a list of words displayed in the Prediction window. Hover your mouse over each word to hear it read aloud.

16. Close Prediction by clicking on the **button.

17. Return to the Speech tab of the Prediction Options and turn off the **Speak when mouse pointer hovers over word** option.

18. Select the **Automatically speak the list of predicted words** check box to specify that you want the Prediction facility to speak each word in the Prediction window.

19. Drag and drop the **Wait time period before starting** track bar until it reaches 2 seconds to specify that you want the Prediction facility to wait 2 seconds before reading the words aloud.

20. Click on the **OK** button to save the settings and to close the window.

21. Return to your Microsoft Word document and then click on the **button on the toolbar to display the Prediction window.

22. Start typing into your document. You will see a list of words displayed in the Prediction window. When you stop typing, the Prediction facility waits for 2 seconds and then starts to read aloud each of the words.
23. Close the Prediction window by clicking on the button.

24. Open the Speech tab of the Prediction Options window again and de-select the **Automatically speak the list of predicted words** check box to stop the Prediction facility from automatically reading words aloud from the Prediction window.

From these 3 options you can choose which one you prefer to use.

**Exercise 6  Learn vocabulary patterns**

In this exercise you will learn how to specify exactly how you want the Prediction facility to learn vocabulary patterns to improve its predictions.

Before you begin this exercise, make sure you have a text file containing a comprehensive list of words and phrases, saved on your computer.

1. Click on the drop down list on the toolbar and select **Prediction Options**.

   You will see the Display tab of the Prediction Options window displayed.

2. Select the **Advanced options** check box in the bottom left-hand corner of the window.

3. Click on the **Learning** tab:

   ![Advanced options check box](image)

4. Click on the **File** button.

   You will see the Open window displayed.

5. Select a file with a '*.txt' file extension and click on the **Open** button.

6. Click on the **OK** button in the Learning tab.
The words and phrases in the text file will now be used by the Prediction facility to provide you with a list of possible words and phrases with which you can finish sentences as you type.

The Prediction facility can also learn words that you have copied to the clipboard. To do this, you simply click on the **Clipboard** button in the Learning tab.

### Exercise 7  Setting up phonetic replacements

In this exercise you will learn how to set up phonetic replacements which will be used in the Prediction facility. Sometimes people make the mistake of spelling words phonetically. For example, typing ‘fone’ instead of ‘phone’. Read&Write 11.5 Gold’s phonetic prediction can use phonetic mappings to help suggest the words that you are trying to spell.

1. Click on the **Prediction** button on the toolbar. You will see the Prediction window displayed.

2. Type the letters *photo* into your document. Note how you are also given predictions beginning with ‘ph’, e.g. ‘photo’.

3. Close the Prediction window.

4. Click on the **Prediction Options** drop down list on the toolbar and select **Prediction Options**.

   You will see the Display tab of the Prediction Options window displayed. Make sure the **Advanced options** check box in the bottom left-hand corner is selected and then click on the Phonetics tab:

   - **Phonetic map** list box
   - **Advanced options** check box

The phonetic replacements already present on the phonetic map are listed in the **Phonetic map** list box.
5. Find the phonetic replacement for ‘fo=pho’ in the **Phonetic map** list box. When you typed the word ‘foto’ in step 2, the Prediction facility was able to use this phonetic replacement to suggest words beginning with ‘photo’ as replacement words.

6. This is where you can add additional replacements by clicking on **New**.

7. Click on the **OK** button to close the Prediction Options window.

> The Prediction facility will only provide you with a list of predictions using phonetic replacements if you have set the context level to ‘More suggestions’ in the Context tab.

**Exercise 8  Setting up the prediction context level**

In this exercise you will learn how to set the context level of predictions. This means that the Prediction facility will suggest words based on probability and/or accuracy depending on which level is set.

1. Click on the drop down list on the toolbar and select **Prediction Options**.

   You will see the Display tab of the Prediction Options window displayed. Make sure the **Advanced options** check box in the bottom left-hand corner is selected and then click on the Context tab:

![Context track bar](image)

2. Drag the **Context** track bar from ‘More suggestions’ to ‘Better context’ and then click on the **OK** button.

3. Click on the **button and then type the following text into your document. Keep an eye on what predictions are offered in the Prediction window:

   **The volcano erupted causing major damage.**

4. Open the Context tab of the Prediction Options window again.
5. Drag the Context track bar from ‘Better context’ back to ‘More suggestions’ and then click on the OK button.

6. Re-type the text into your document. Watch what predictions are now offered in the Prediction window.

There is a stark contrast between ‘More suggestions’, the majority of which appear with a black triangle, and ‘Better context’ which appear with a green circle. With ‘Better context’ there are fewer words predicted but they are more accurate. Choose which setting best suits you.

7. Click on the button on the top right-hand corner of the Prediction window to close it.

Exercise 9 Adding prediction word banks

In this exercise you will learn how to add the prediction word banks you have created or downloaded. This means that the Prediction facility will suggest words based on the word banks you have chosen to use.

1. Click on the drop down list on the toolbar and select Prediction Options. You will see the Display tab of the Prediction Options window displayed. Make sure the Advanced options check box in the bottom left-hand corner is selected and then click on the Context tab:

![Prediction Options window]

1. Click on the check box beside Applied sciences in the Prediction word banks section.

This will ensure that all words and phrases in the Applied sciences prediction word bank are added to the Prediction facility.

2. Scroll down the list of Prediction word banks until you see the ‘Volcano’ word bank. This is the word bank you added in Exercise 2. Notice how the check box is
already selected. This is because user-created word banks are automatically selected for use.

3. Right-click on the ‘Volcano’ word bank and select the **Preview word bank** option from the menu that appears.

   ![You can only preview words in word banks that you have downloaded or user-created word banks.](image)

   A separate window is displayed which lists all of the words and phrases in the word bank. You can search the word bank for a particular word or phrase by typing directly into the **Search word bank** field. The list is automatically filtered as you type.

4. Click **Close** to close this window and return to the Context tab.

5. Click **OK** to close the Prediction Options.

### Exercise 10  Adding individual words to the prediction word bank

In this exercise you will learn how to add words to the prediction database. This means that when you next use the Prediction window, it will suggest words based on the words you have added.

1. Click on the drop down list on the toolbar and select **Prediction Options**.

   You will see the Display tab of the Prediction Options window displayed. Make sure the **Advanced options** check box in the bottom left-hand corner is selected and then click on the Edit Lists tab:

   ![Custom prediction file radio button](image)
   ![Search for phrases containing text box](image)
   ![Advanced options check box](image)

2. Select the **All prediction files** radio button to specify that you want to search for a phrase in all available prediction databases.
3. Type the word **dead** into the **Search for phrases starting with** text box and then click on the **Search** button. You will see a list of all the phrases containing the word ‘dead’ displayed in the **Phrase search results** list box.

You will notice that the phrase ‘dead quiet’ is not listed. To add this phrase to the list:

4. Select the **Custom prediction file** radio button and then click on the **New** button. You will see the Add a new word or phrase window displayed.

5. You must select the **Other** radio button because the phrase ‘dead quiet’ is an adjective. You will see a second Add a new word or phrase window displayed:

6. Type the phrase **dead quiet** into the **New word or phrase to add** text box and then type the following text into the first three **Phrases** text boxes:

   - **It was dead quiet**
   - **She is dead quiet**
   - **They were dead quiet**.

7. Click on the **OK** button in both the Add a new word or phrase window and the Prediction Options window.

8. Click on the **button and then type the following text into your document followed by a space: **It was dead.** Keep an eye on the Prediction window. You will see the word ‘quiet’ listed. Click on ‘quiet’ or use the appropriate function key to insert it into your document.
<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use Prediction.</td>
<td></td>
</tr>
<tr>
<td>How to teach the Prediction new vocabulary.</td>
<td></td>
</tr>
<tr>
<td>How to download Prediction word banks.</td>
<td></td>
</tr>
<tr>
<td>How to change the Prediction window.</td>
<td></td>
</tr>
<tr>
<td>How to set up the speech options.</td>
<td></td>
</tr>
<tr>
<td>How to learn vocabulary patterns.</td>
<td></td>
</tr>
<tr>
<td>How to set up a phonetic replacement.</td>
<td></td>
</tr>
<tr>
<td>How to set the context level.</td>
<td></td>
</tr>
<tr>
<td>How to add additional word banks.</td>
<td></td>
</tr>
<tr>
<td>How to add words to the Prediction.</td>
<td></td>
</tr>
</tbody>
</table>
13. Using the Dictionaries
In this section you will learn how to:

- use the Basic dictionary
- use the Advanced dictionary
- use the Web dictionary
- use the Picture dictionary.

Type the following text onto a new line in your document:

The earth revolves around the sun.

Exercise 1  Using the Basic Dictionary
In this exercise you will learn how to use the dictionary to find basic definitions.

1. Click on the drop down list on the toolbar and select Basic Definitions.
2. Highlight the word ‘earth’.
3. Click on the button.
   You will see a list of definitions for the word ‘earth’ displayed in the Dictionary meanings list box.

4. Click on the first definition and then click on the button on the Read&Write 11.5 Gold toolbar to hear it read aloud.
5. To close the Dictionary - Basic Definitions window, click on the button on the top right-hand corner of the window.
Exercise 2  Using the Advanced Dictionary

If you use more complex words you may prefer to use the Advanced Dictionary. To use this:

1. Click on the drop down list on the toolbar and select **Advanced Definitions**.
2. Highlight the word ‘earth’ in your text.
3. Click on the button.

You will see the Dictionary - Advanced Definitions window displayed. The word ‘earth’ is displayed in the **Original word** text box:

Notice that these are more advanced definitions.

You can use the Advanced search to look for alternative words similar to a Thesaurus. To do this:

4. Click on the **Advanced** button and select **Words related to ‘earth’** from the popup menu. You will see a list of definitions for the word ‘earth’ in the **Dictionary meanings** list box.
5. Click on the definition that begins with ‘The 3rd planet from the sun….’.
6. Click on the word ‘world’ in the **Inflections/Synonyms** list box and then click on the button on the Read&Write 11.5 Gold toolbar to hear it read aloud.
7. Click on the **Change** button to replace the word ‘earth’ with the word ‘world’ in your text.
Exercise 3  Using the Web Dictionary
In this exercise you will learn how to use Read&Write 11.5 Gold to find definitions on the Internet. To do this:

1. Click on the drop down list on the toolbar and select Web Definitions. From now on the Web Definitions Dictionary will be displayed when you use the dictionary.

2. Highlight the word ‘world’ in your text. Or the word ‘earth’ if you did not complete the previous exercise.

3. Click on the button.
   The Web Dictionary will be displayed.

4. You will be able to use Read the web option to have the definitions read to you.

5. Click on the button on the top right-hand corner of the window when you have finished viewing this page.

Exercise 4  Using the Picture Dictionary
In this exercise you will learn how to use the Picture Dictionary to find graphical representations of words.

You must be online in order to use the Picture Dictionary.

1. Click on the button. Highlight the word ‘world’.
   You will see the Picture Dictionary window displayed:

   ![Picture Dictionary](image)

   world hyperlink

2. Highlight the word ‘revolve’ in your document.
   The Picture Dictionary window displays a picture representing the word revolve.

3. Click on the ‘revolve’ hyperlink. This will open the dictionary.

   The Picture Dictionary will use which ever dictionary you have currently selected from the drop down list, i.e. Basic, Advanced or Web Definitions.
Definitions for the word ‘revolve’ are listed.


You can highlight words in any of the Read&Write 11.5 Gold facilities to display pictures in the Picture Dictionary window.

5. Click on the button on the top right-hand corner of the Picture Dictionary window to close it.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the basic dictionary.</td>
<td></td>
</tr>
<tr>
<td>How to use the advanced dictionary.</td>
<td></td>
</tr>
<tr>
<td>How to use the web dictionary.</td>
<td></td>
</tr>
<tr>
<td>How to use the picture dictionary.</td>
<td></td>
</tr>
</tbody>
</table>
14. Using the Word Wizard

In this section you will learn how to:

- use the Word Wizard to find alternative words (like a Thesaurus).

**Exercise 1  Searching for words using the Word Wizard**

In this exercise you will learn how to use the Word Wizard to search for alternative words.

To complete this exercise, click on the button until you can see the All Features toolbar. The tooltip for this button will help you identify the toolbar you need.

1. Type volcano onto a new line in your document and then highlight it.

2. Click on the button on the toolbar.

   You will see the first window in the Word Wizard, which displays the highlighted word.

3. Click on the Next button. You will see the next window in the Word Wizard. All the results can be read by clicking on them then the button.

4. Select the first sense (1), i.e. Vent, Volcano ‘A fissure in the earth's crust (or in the surface of some other planet) through which molten lava and gases erupt’. Click on the Next button. You will see the next window in the Word Wizard.

5. Select the Words related to 'volcano' radio button and then click on the Next button. You will see the next window:

6. Click on the first phrase (1) in the Related words or phrases list box, i.e. ‘Crack, Cleft, Crevice, Fissure, Scissure. You can view a list of related synonyms displayed in the Synonyms list box.
7. Select ‘fissure’ from the Synonym list box and then click on the Change button. ‘fissure’ replaces the word ‘volcano’ in your text.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Word Wizard.</td>
<td></td>
</tr>
</tbody>
</table>
15. Using the Sounds Like and Confusable Words facility

In this section you will learn how to:

- use the Sounds Like and Confusable Words button to identify and correct words that sound similar or which may be confused with others
- add additional confusing words
- return always ignored homophones to the list.

Type the following text into a blank Microsoft Word document:

A magma chamber is were magma from deep within the planet gathers. Pipes allow the larva too get threw to the surface.

Exercise 1 Identifying sounds like and confusable words

In this exercise you will learn how to identify sounds like (homophones) and confusable words in your document to help you ensure you have typed the correct word.

1. Click anywhere in the text you have just typed then click on the button on the toolbar.

You will see the Same Sounding Words window displayed:

The first homophone or confusable word in the text is displayed, i.e. ‘were’.

The homophones and confusable words in your text are highlighted in blue. The homophones are ‘were’, ‘the’, ‘too’, ‘threw’ and ‘to’. The confusing words in the sentence are ‘within’ and ‘larva’.

2. Make sure the word ‘were’ is selected in the Homophones list box and read the definition in the Word meaning list box. To hear it read aloud, click on the
definition and then click on the button on the toolbar. This is not the correct word.

3. Click on the word ‘where’ in the Homophones list box and read the definition in the Word meaning list box. To hear it read aloud, click on the definition and then click on the button on the toolbar. This is the correct word.

4. Click on the Change button. The word ‘were’ is replaced in your document by the word ‘where’.

The Same Sounding Words window moves on to the next homophone or confusable word in the sentence, which is ‘within’.

5. This is the correct word. Click on the Ignore button.

The Same Sounding Words window moves on to the next homophone or confusable word, which is ‘the’.

6. This is the correct word. Click on the Always Ignore button. This means that the word ‘the’ and all its associated homophones will be ignored from now on.

You can return words that you have decided to Always Ignore. How to do this is explained in Exercise 3 Returning Always Ignore words

The Same Sounding Words window moves on to the next homophone or confusable word, which is ‘larva’.

7. Select ‘lava’ from the Homophones list box as this is the correct word.

8. Click on the Change button.

The Same Sounding Words window moves on to the next homophone or confusable word, which is ‘too’.

9. Select ‘to’ from the Homophones list box as this is the correct word.

10. Click on the Change button.

The Same Sounding Words window moves on to the next homophone or confusable word, which is ‘threw’.

11. Select the word ‘through’ which is the correct word. Click on the Change button.

The Same Sounding Words window moves on to the next homophone or confusable word, which is ‘to’.

12. This is the correct word. Click on the Always Ignore button. This means that the word ‘to’ and all its associated homophones will be ignored from now on.

13. The Same Sounding Words panel closes. Your text should now be like this:
A magma chamber is where magma from deep within the planet gathers. Pipes allow the lava to get through to the surface.

What else can you do:

- Add other words that you get confused with – Adding additional confusing words.
- Return always ignored words to the Sounds Like and Confusable Words – Returning Always Ignored words.

Further Exercises

Exercise 2 Adding additional confusing words

If there are other words which you get confused with which are not in the Sounds Like and Confusable words facility you can add them.

1. Click on the drop down list on the toolbar and select Edit Homophones.

The Similar tab of the General Options window is displayed:

2. Insert the cursor in the Search for a homophone box and type ‘concave’. Click on the Search button.

3. A message box is displayed saying that ‘concave’ cannot be found in the homophones database and asks if you wish to add a new homophone group. Click on the Yes button.

4. Insert the cursor in the left meaning column and type ‘concave’. In the right column type ‘curving inward’.

5. Insert the cursor in the next line of the left meaning column and type ‘convex’. In the right column type ‘curving outward’.


6. Click on the **Save** button.

7. A message box is displayed asking you if you are sure you want to save this group and make a permanent change. Click on the **Yes** button to save the change.

8. The Same sounding Words window is re-displayed:

![Same Sounding Words window](image)

9. Click on the **OK** button to close the General Options window.

10. Type the following text into a blank Microsoft Word document:

    **The surface of the water droplet was convex.**

11. Use the **button** to check if this is correct.

**Exercise 3  Returning Always Ignored words**

In Exercise 1 words were excluded from the Sounds Like and Confusable words feature using the Always Ignore button. You may wish to add these words back. To do this:

1. Click on the **drop down list** on the toolbar and select **Edit Homophones**.

2. The Similar tab of the General Options window is displayed:
3. Click on **Reset ignore list**. The **Stop Ignoring Homophones and Confusing Words** panel appears:

4. Click on the check boxes beside ‘the’ and ‘too’.

5. Click on **OK** to close the window.

6. Click on the **OK** button to close the General Options window.

   The words ‘the’ and ‘too’ have now been added back to the Sounds Like and Confusable Words feature.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to identify same sounding and confusing words.</td>
<td></td>
</tr>
<tr>
<td>How to add additional confusing words.</td>
<td></td>
</tr>
<tr>
<td>How to return Always Ignored words.</td>
<td></td>
</tr>
</tbody>
</table>
16. Using the Verb Checker
In this section you will learn how to:

- use the Verb Checker.

Type the following text into a blank Microsoft Word document:

* I seen a volcano erupt. *

**Exercise 1 Using the Verb Checker**

In this exercise you will learn how to use the Verb Checker to search for verb conjugations of the word ‘seen’ so that you can make sure you are using the correct tense in your document.

1. Select the word ‘seen’.

2. Click on the button on the toolbar. You will see the Verb Checker window displayed:

3. Click on the button. You will see the second step of the Verb Checker displayed:

4. Select the **Is this in the past?** radio button and then click on the button. You will see the third step of the Verb Checker displayed:
The verb is shown in sentence format preceded by different personal pronouns, i.e. I, you (singular), he, she, we, you (plural) and they. Variations of these sentences are shown in the past tense.

5. Place your cursor in the sentence ‘I saw’ in the Past list box.

6. Click on the button on the toolbar to hear the sentence read aloud. This is the correct verb.

7. Click on the button in the Verb Checker window.

   The word ‘seen’ is replaced with ‘saw’. This has corrected your text.

8. Close the document.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Verb Checker.</td>
<td></td>
</tr>
</tbody>
</table>
17. Using the Calculator

In this section you will learn how to:

- use the Standard Calculator
- use the Scientific Calculator
- evaluate calculations in a document
- convert values in a document.

Exercise 1  Using the Standard Calculator

In this exercise, you will learn how to use the Standard Calculator.

1. Click on the drop down list on the toolbar and select Standard Calculator.
   You will see the Standard Calculator window displayed.

2. Click on the following buttons: 5 + 9 + 4 =

   If you click on the wrong button you can undo your last action by clicking on the Undo button. If required, you can click on this button several times if you decide that you want to undo several actions.

   The system calculates the sum and then reads it aloud. Your calculator should look similar to this:

3. Click on the C (clear all values) button. To clear the sum.

4. Have the following options turned on in the Speech menu:
   - Speak on Click
   - Confirm on Equals (this should already be switched on).

5. Complete the following using the View menu:
   - select Background Color, then select a colour from the colour palette, and then click on the OK button
   - select Foreground Color, then select a colour from the colour palette, and then click on the OK button
6. Notice how the calculator now has the colours you have set up.

7. Click on the following buttons: \(55 + 7 + 50 =\)

8. Notice how the buttons are spoken when you click on them and the whole sum is read when you click on the = button.

9. Click on the \(\times\) button on the top right-hand corner to close the Standard Calculator.

**Exercise 2 Using the Scientific Calculator**

In this exercise, you will learn how to use the Scientific Calculator.

1. Click on the drop down list on the toolbar and select **Scientific Calculator**. You will see the Scientific Calculator window displayed.

2. Click on the following buttons: \(55 + 7 + 50 =\)
   
   The answer to the calculation is displayed.

3. Click on the \(C\) button to clear the Input Display.

4. Click on the \(\times\) button on the top right-hand corner to close the Scientific Calculator.

**Exercise 3 Converting values in documents**

In this short exercise, you will learn how to convert values in your document. In this example you are going to convert a value in centimetres to inches.

1. Type the following into your Microsoft Word document: **167**.

2. Highlight the figure in your document.
3. Click on the drop down list on the toolbar, point your cursor over **Convert**, then **Length**, then **centimeters**, and then select **to inches** as shown here:

![Drop down list showing conversion options](image)

The figure in your document is replaced by the inches equivalent (65.7480336).

**What else can you do:**

- Use variables and Constants – **Using Variables and Constants**.
- Complete your sum in your document – **Evaluating calculations within documents**.

### Further Exercises

**Exercise 4 Using Variables and Constants**

1. Click on the drop down list on the toolbar and select **Scientific Calculator**.
2. Click on the View menu and select **Variables and Constants** to display the Stored Constants and Variables window:

![Stored Constants and Variables window](image)

3. Type **vat=0.20** into the space provided and then click on the **Save** button.
4. Click on the **×** button on the top right-hand corner to close the Calculator.

You will see this variable being used in the next exercise.
Exercise 5  **Evaluating calculations within documents**

In this exercise, you will learn how to evaluate calculations in your document without having to access the calculators.

1. Type the following into your Microsoft Word document: \(50.00 \times \text{vat}\)

2. Highlight the sum in your document and then click on the drop down list on the toolbar and select **Evaluate in Document**.
   
   The answer is inserted after the calculation.

3. Type the following into your Microsoft Word document: \(128 - 5\)

   Notice you do not put in the = sign.

4. Highlight the sum in your document and then click on the drop down list on the toolbar and select **Evaluate in Document**.

   The answer is inserted after the calculation.

---

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>✔️</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Standard Calculator.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to use the Scientific Calculator.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to convert values.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to add variables and constants.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to evaluate in document.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
18. Using the Scanning Facility

In this section you will learn how to:

- scan a page to PDF, Word, HTML and ePub
- scan single documents
- scan multiple documents
- scan a file
- scan from a digital camera
- create a style sheet for HTML.

To complete this section, you must ensure that you have set up your scanner correctly and have two A4 coloured documents containing text and pictures.

Exercise 1 Performing a scan

In this exercise you will learn how to perform a scan into Microsoft Word, Internet Explorer, Adobe Reader or ePub.

1. Place a page into your scanner.

2. Click on the drop down list and make sure Scan to PDF is selected. You will know that it has been selected if you can see a dot beside it:

3. Click on the button on the toolbar.

4. You will see the Scan multiple pages window:

5. Click on Scan.

6. Once the scan is complete click on Finished Scanning.

7. You will see the Save As window displayed.
8. Type **My Scan to PDF** in the **File Name** field, locate a file in which to save the scan, and then click on the **Save** button.

   The Scanning facility scans your document. When the scan has completed, you will see the scanned image displayed. From here you can use PDF Aloud to read the document.

   This type of scan is recommended if you simply wish to scan a document and have it read. Scanning into PDF provides a ‘near’ picture image of the original document.

9. Click on the **drop down list and select** **Scan to Word**.

10. Click on the **button on the toolbar**.

11. You will see the **Scan multiple pages** window:

12. Click on **Scan**.

13. Once the scan is complete click on **Finished Scanning**.

   You will see the Save As window displayed.

14. Type **My Scan to Word** in the **File Name** field, locate a file in which to save the scan, and then click on the **Save** button.

   The Scanning facility scans your document. When the scan has completed, you will see the scanned image displayed in Microsoft Word.

   This type of scan is recommended if you want to edit the scanned document.

15. Click on the **drop down list and select** **Scan to HTML**.

16. Click on the **button on the toolbar**.

17. You will see the **Scan multiple pages** window:
18. Click on **Scan**.

19. Once the scan is complete click on **Finished Scanning**.

   You will see the Save As window displayed.

20. Type **My Scan to HTML** in the **File Name** field, locate a file in which to save the scan, and then click on the **Save** button.

   The Scanning facility scans your document. When the scan has completed, you will see the scanned image displayed in Internet Explorer.

   This type of scan is recommended if you want to display the document using your own choice of coloured fonts and backgrounds. Instructions on how to change fonts and backgrounds is explained in **Exercise 7 Scanning to HTML**.

21. Click on the drop down list and select **Scan to ePub**.

22. Click on the **button on the toolbar.

23. You will see the **Scan multiple pages** window:
24. Click on **Scan**.

25. Once the scan is complete click on **Finished Scanning**.

You will see the Save As window displayed.

26. Type **My Scan to ePub** in the **File Name** field, locate a file in which to save the scan, and then click on the **Save** button.

The Scanning facility scans your document. When the scan has completed, you see the scanned image displayed as an ePub.

This type of scan is recommended if you want to read the scanned document using an ePub reader.

27. Click on the drop down list and select the format that you would prefer to scan to.

---

**Exercise 2  Scanning single pages**

In this exercise you will learn how to set up the scanner options and scan single documents.

1. Click on the drop down list on the toolbar and select **Scanning Options**.

   You will see the Options tab of the Scanner Settings window displayed:

   ![Scanner Settings Window]

   - **Image Resolution** section
   - **Multipage Settings** section

2. Select the **600 DPI** radio button from the **Image Resolution** section. This will provide the best quality scan.

3. Select the **Single pages** radio button from the **Multipage Settings** section.

4. Click on the **OK** button to save your settings.
5. Place a single page into your scanner and then click on the drop down list on the toolbar and select **Scan to Word**.

6. Click on the button.

   You will see the Save As window displayed.

7. Type **My Single Scan to Word** in the **File Name** field, locate a file in which to save the scan, and then click on the **Save** button.

8. Your page is scanned and automatically opened in Microsoft Word.

---

### Exercise 3  Scanning multiple documents

In this exercise you will learn how to alter scanning multiple documents.

1. Click on the drop down list on the toolbar and select **Scanning Options**.

2. You will see the Options tab:

   ![Options Tab]

3. Select the **Multiple pages (countdown)** radio button from the Multipage Settings section. Type **20** in the **Countdown** text box.

4. Click on the **OK** button to save your settings.

5. Click on the button.

6. You will see the **Scan multiple pages** window:

7. Click on **Scan**.

8. Your page is scanned and then you will see a 60 second countdown displayed. This means you have 60 seconds before your next page will be scanned.
9. Place another page into your scanner.

   Read&Write 11.5 Gold will automatically scan this page 20 seconds after the first page has been scanned.

10. Once the scan is complete click on **Finished Scanning**.

   You will see the Save As window displayed.

11. Type **My Multiple Scan to Word** in the **File Name** field, locate a file in which to save the scan then click on **Save**.

### Exercise 4  Scanning from a file

You can also scan from a saved image file on your computer.

1. Click on the drop down list on the toolbar and select **Scan to PDF**.

2. Click on the drop down list and select **Scan from File**.

3. Click on the **button**.

   You will see the Save As window displayed.

4. Type **My File Scan to PDF** in the **File Name** field, locate a file in which to save the scan.

5. The Open files window is displayed.

6. Browse to the location where you store your images, select the image and then click on the **Open** button. The image is scanned and opens as a PDF.

### Exercise 5  Scanning from a digital camera

In this exercise you will learn how to scan from a photo you have taken with your digital camera. This is useful if you don't have access to a scanner.

⚠️ To complete this exercise, your camera **must** be WIA compatible. If it is not, you can use the 'Scan from File' as detailed in Exercise 5 - Scanning from a file.

1. Place an A4 page of paper containing text on your desk and take a photo of it.

2. Connect your camera to your computer using your USB cable.

3. Click on the drop down list on the toolbar and select **Scan from WIA**.

4. Click on the **icon**.

   You will see either of the following windows displayed:
• Select Device window – this will appear if you have more than one device attached to your computer. Select your camera from the list and then click on the OK button. The Get pictures from window is displayed. Locate and select the photo you have just taken and then click on the Get Pictures button.

• Get Pictures from window – locate and select the photo you have just taken and then click on the Get Pictures button.

When your document is displayed you can use the features in Read&Write 11.5 Gold to read aloud the text in the way that you want.

What else can you do:

• Set up an HTML style sheet to have the text displayed in a format of your choosing – Scanning to HTML.

Further Exercise

Exercise 6  Scanning to HTML

1. Click on the drop down list on the toolbar and select Scanning Options. Click on the Output tab.

   You will see the Output tab of the Scanner Settings window displayed:

   2. Click on the HTML Options. This will open the HTML Output Options:
3. Select the font, font colour, background colour and font size you would like to use.

4. Click on OK.

5. Click on the drop down list and select Scan to HTML.

6. Click on the button on the toolbar.

7. You will see the Scan multiple pages window:

8. Click on Scan.

9. Once the scan is complete click on Finished Scanning.

   You will see the Save As window displayed.

10. Type My HTML scan in the File Name field, locate a file in which to save the scan, and then click on the Save button.

   The Scanning facility scans your document. When the scan has completed, you will see the scanned page displayed using your preferences in your web browser.
## Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to scan to PDF, MS Word, HTML and ePub.</td>
<td></td>
</tr>
<tr>
<td>How to scan single pages.</td>
<td></td>
</tr>
<tr>
<td>How to scan multiple pages.</td>
<td></td>
</tr>
<tr>
<td>How to scan from a file.</td>
<td></td>
</tr>
<tr>
<td>How to scan from a digital camera.</td>
<td></td>
</tr>
<tr>
<td>How to create a style sheet for HTML.</td>
<td></td>
</tr>
</tbody>
</table>
19. Using the Fact Finder
In this section you will learn how to:

- use the Fact Finder to find information
- add other search engines to the Fact Finder.

Exercise 1 Using the Fact Finder
In this exercise you will learn how to search for facts using the default search engine and change the default search engine.

1. In Microsoft Word type in the word ‘volcano’.

2. Select the word and click on the button.

   Your browser window opens displaying the search results for ‘volcano’ in Google.

3. Close this webpage.

4. Click on the drop down list on the toolbar and select Fact Finder Options. You will see the Fact Finder Options window displayed:

   ![Fact Finder Options window]

5. Click on the Change Default button and then point your cursor over the Search using option. You will see a drop down list displaying different categories of search engines.

6. Point your cursor over General and select the Yahoo search engine.

7. Click on the OK button to save Yahoo as the default search engine.

8. Select the word ‘volcano’ again and click on the button.

   Your browser window opens displaying the search results for ‘volcano’ in Yahoo.

9. Close this webpage.
Exercise 2  Adding search engines
In this exercise you will learn how to add a new search engine to Read&Write 11.5 Gold for use with the Fact Finder facility.

1. Click on the drop down list on the toolbar and select Fact Finder Options. You will see the Fact Finder Options window displayed.

2. Click on the Add New Entry button.
You will see the Download Fact Finder Sites window, which allows you to download new search engines from www.texthelp.com.

3. Select the check box beside the search engine you want to download. Take note of the Category under which it is listed. For example, the CNN search engine is listed under the ‘News’ category.

4. Click on the Add button.

5. Click on the Close button when you have finished downloading search engines.

6. Click on the drop down list on the toolbar and then point your cursor over the Search using option. Point your cursor over the category to which your newly downloaded search engine belongs. You can now see it displayed in the list. It is now available for use.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Fact Finder.</td>
<td></td>
</tr>
<tr>
<td>How to add additional search engines.</td>
<td></td>
</tr>
</tbody>
</table>
20. Using the Fact Folder

In this section you will learn how to:

- add text facts
- add images
- change fact details and properties
- export facts.

The Fact Folder is used mainly to add facts from the Internet.

Exercise 1  Adding text facts

In this exercise you will learn how to use the Fact Folder to save a paragraph of text as a new fact.


2. Choose one of the results and click on the link.

3. On the webpage highlight some interesting information and then click on the button. The Fact Details window is displayed.

4. Type the text Volcano into the Title text box.

5. Type the name of the Author in the Author text box.

   The locations and URLs of any documents and websites that are open are displayed in the Sources list box.

6. There will be a tick in the check box beside the location of the website you have collected the text from.

7. Click on the … button beside the Categories text box. You will see the Select Categories window displayed.

8. Click on the Add button and type the text Volcanoes in the text box provided.

9. Click on the OK button to add the new category.
10. Select the check box beside ‘Volcanoes’ in the Category List and then click on the OK button.

11. In the Description text box, type something to explain what the text is about and then click on the OK button.

12. You will see a message pop up from the system tray informing you that the fact ‘Volcano’ has been added.

Exercise 2 Adding images

In this exercise you will learn how to use the Fact Folder to save an image from a web page.

1. Find a picture of a volcano on the Internet and then click on the drop down list and select the Add Web Image option. You will see the Texthelp Web Hover popup on the bottom right-hand corner of your screen.

2. Hover your mouse over the image of a volcano until you see it appear in this popup and then click on it. You will see the Fact Details window displayed.

3. Type the text Volcano picture into the Title text box.

4. Type the name of the author of the website in the Author text box.

5. The check box beside the URL which contains the image you have just selected will have automatically been selected.

6. Click on the button beside the Categories text box. You will see the Select Categories window displayed.

7. Select the check box beside ‘Volcano’ in the Category List and then click on the OK button.

8. Enter the text Picture of a volcano in the Description text box and then click on the OK button.

9. You will see a message pop up from the system tray informing you that the fact ‘Volcano picture’ has been added.
Exercise 3  Changing fact details and properties
In this exercise you will learn how to change the details of facts that you have already added to the Fact Folder. You will also learn how to update fact content.

1. Click on the drop down and select Review Facts.

2. Click on the ‘Volcano picture’ fact in the Fact Folder window. You will see a preview of the image in the Preview pane.

3. Click on the button. You will see the Fact Details window displayed.

4. Type the text Also lists other useful information in the Description text box and then click on the OK button. The description is updated in the Fact Folder window.

5. Click on the ‘Volcano’ fact and then click on the button. You will see the Displaying Fact window.

6. Add the text Volcanoes tend to occur near tectonic plates to the text that is already there.

7. Click on the OK button.

8. Close the Fact Folder by clicking on the button.

Exercise 4  Exporting facts from the Fact Folder
In this exercise, you will learn how to export facts to a Microsoft Word document.

1. Click on the drop down list and select the Review Facts option. The Fact Folder opens:

![Fact Folder window](image)
2. In the Fact Folder window, select Volcano from the category drop down list. This will ensure that only the facts you have added to this category are displayed.

3. Click on the button.

You will see the Bibliography window displayed.

4. Select the Harvard option from the drop down list and then click OK.

Read&Write 11.5 Gold automatically creates the Microsoft Word document and lists all of the facts for the Volcano category. A bibliography in the Harvard style is also included.

5. After you have viewed your new Microsoft Word document, close it and return to the Fact Folder window.

6. Select the ‘Volcano’ fact and then click on the button.

You will see the Bibliography window displayed.

7. Select the APA option from the drop down list and then click OK.

Read&Write 11.5 Gold automatically creates the Microsoft Word document with the selected fact for the Volcano category. A bibliography in the APA style is also included.

8. Close the Fact Folder by clicking on the button.

You can also export to a HTML document. Click on the Tools menu and select the Select All Facts or select the facts you wish to export. Click on the Tools menu again and select the Export Selected Facts option. You will see the Export window displayed. Select the Web Export option.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to add text.</td>
<td></td>
</tr>
<tr>
<td>How to add images.</td>
<td></td>
</tr>
<tr>
<td>How to change fact details and properties.</td>
<td></td>
</tr>
<tr>
<td>How to export facts.</td>
<td></td>
</tr>
</tbody>
</table>
21. Using the Fact Mapper
In this section you will learn how to:

- create fact maps
- add notes to facts
- use the Image Library to add images to a map
- link facts
- changes how a fact map is displayed
- brainstorm
- export Fact Maps
- save and Open a Fact Map.

You can use the Fact Mapper, which is an online graphical user interface, to add different types of facts to a fact map. You can then link each of the facts to each other to represent a relationship between them. This enables you to create a diagram of your idea or information on a subject, and therefore help you to understand and remember it better.

Exercise 1 Working with the Fact Mapper

1. To access the Fact Mapper, click on the button on the Read&Write 11.5 Gold toolbar. You will see the Fact Mapper window displayed.

2. The first time you attempt to use any of the facilities in Fact Mapper, you may see the following message box. Click on the Allow access button.

3. In the Theme palette you can choose the colour of your Fact Mapper window:
4. Wait a few moments while the Fact Mapper changes the colour of the window. Allow access if this appears again.

5. Click on the **File** menu in order to view the File toolbar:

   ![File menu]

   The ‘Menu type’ label can help you find this menu.

6. Click on the **Fact Map** menu in order to view the Fact Map toolbar:

   ![Fact Map menu]

   When working with fact maps, make sure you save before closing the Fact Mapper or you will lose your work.

   Click on the [ ] and [ ] buttons at the top right-hand-side of the Fact Mapper window to select the zoom level at which you want to view the fact map.

**Exercise 2  Creating fact maps**

In this exercise, you will learn how to create a fact map and add facts.

1. Click on the [ ] button on the Fact Map toolbar.

   A new fact is displayed in the main work area.

2. Type the text **America** into the new fact:

   ![America fact]

3. Click on the America fact and then click on the [ ] button.

   A new fact is displayed in the main work area and is linked to the first fact.

4. Type the text **Map of America** into the new fact.

5. Add the following facts to the fact map using the same process:

   - **United States of America**
   - **American States**

   Make sure that you click on the America fact before you add them.

   You may need to drag and drop the last fact onto a different position on the fact map to ensure that you can easily see it coming from the America fact.
• Flag.

The Fact map should look something like this:

6. Select the ‘Flag’ fact and then click on the button. This fact is removed from the fact map.

7. Select the ‘American States’ fact then click on the button.

8. Change the name of the fact to the following: 50 States.

Exercise 3 Adding notes to facts
In this exercise, you will learn how to add notes to facts.

1. Select the “50 States” fact.

2. Type the following text into the text area at the bottom of the Fact Mapper window:

There are 50 states in the USA.
3. Click on the button. The note is added to the fact. It is represented by the icon.

4. Select the ‘United States of America’ fact.

5. Type the following text into the text area at the bottom of the Fact Mapper window:

   **The motto for the USA is ‘In God We Trust’.**

6. Click on the button. The note is added to the fact.

7. Select the ‘50 States’ fact and then click on the button at the bottom of the Fact Mapper window. The note is removed from the fact.

---

Exercise 4  **Using the Image Library**

In this exercise, you will learn how to add images from the Image Library to your fact map. You will also learn how to add your own custom images for use in fact maps.

1. Type **America** in the Search textbox at the bottom right-hand-side of the Fact Mapper window.

2. Click on the Go button. The Search tab expands to display the list of images that match your search word.

3. Click and hold down your left mouse button on the American Coin image and drag and drop it onto the ‘America’ fact in the fact map:

   ![American Coin Image]

   If you find it difficult to drag and drop images, you can right-click on an image and select ‘Copy Image’, then select a fact in the fact map and click on the button (on the Fact Map menu).

4. Click and hold down your left mouse button on the American Football image and drag and drop it onto the ‘50 states’ fact in the fact map:

   ![American Football Image]

5. Click on the button on the Search tab.
6. Click on the drop down list of image categories. You will see lots of categories from which you can choose an image. Select the **Classic Tourism** option.

7. Click and hold down your left mouse button on the Statue of Liberty image and drag and drop it onto the ‘50 states’ fact in the fact map:

![50 states]

**Exercise 5  Adding your own images**

In this exercise you will learn how to add your own images to the Image Library so you can use them in your Fact Mapper.

1. Click on the  (Manage Custom Images) button (on the File menu).

   ![Manage Custom Images]

   *If this option is not available contact your network administrator.*

2. If a warning box appears click on the **Allow access** button.

3. Click on the  (Add a new image) button (on the **Image** menu). The Add Multiple Images window is displayed.

4. Click on the **Select Images** button. The Select file(s) to upload by factmapper.texthelp.com window is displayed.

5. Browse to the location in your directory where you store your images.

6. Click on an image and then click **Open**.

7. Make sure the **All images received** message is displayed and then click the **OK** button.

   The selected image is shown in the Fact Mapper Custom Image Library window.

8. Close the Fact Mapper Custom Image Library window by clicking on the  (Close) button.

9. In the Search tab, select the **Custom** option from the Category drop down list.

10. The image you uploaded is listed. You can now add this to your fact maps.

   ![Custom Image Library]

   *You should make sure that your images are named appropriately to allow you to search for them more easily.*
Exercise 6  **Linking facts**

In this exercise, you will learn how to remove links between facts and create them again.

1. Click on the ‘Map of America’ fact and then click on the button (on the Fact Map menu). The fact is highlighted in blue to show that it has been selected.

2. Click on the ‘America’ fact.

   The link between the two facts is removed.

3. Repeat this process to remove the remaining links from the fact map:
   - United States of America
   - 50 States.

4. To reinsert the links:

5. Click on the ‘America’ fact and then click on the button (on the Fact Map menu). The fact is highlighted in blue to show that it has been selected.

6. Click on the ‘Map of America’ fact.

   You will now see a line linking the two facts.

7. Repeat this process to link the remaining facts to the ‘America’ fact.

Exercise 7  **Changing how a fact map is displayed**

In this exercise you will learn how to specify how you want your fact map displayed.

1. Click on the drop down list (on the Fact Map menu) and select the Document Outline option. Your fact map is now displayed in a bulleted list.

2. Click on the drop down list again and select the Tree option. Your fact map is now displayed in a tree view.

3. Change it back to the way it was originally by selecting the Fact Map option from the drop down list.

4. Select ‘America’ in your fact map and then click on the button. You will see the Arrange Facts window displayed:
You were asked to select ‘America’ because it is the category to which all of the facts are linked.

5. Select the **Bottom Up Tree** arrangement and then click on the **OK** button.

The description of each arrangement will help you decide which one you want to use in future.

The facts in your fact map are rearranged so that the American flag is displayed at the bottom and all the other facts are displayed above.

**Exercise 8  Brainstorming**

In this exercise you will learn how to use the Fact Mapper to brainstorm. This will entail adding several American states to a fact map as quickly as possible.

1. Click on the **Fact Map** button (on the File menu). Then click **OK**.
   
   A blank fact map is opened in the Fact Mapper and the Fact Map menu is displayed at the top.

2. Click on the **Fact Map** button.

   A new fact is displayed in the main work area.

3. Type the text **American states** into the new fact:

   ![American states](image)

4. Make sure the American states fact is selected and then click on the **Fact Map** button.

   A new fact is displayed on top of the American states fact.
5. Type the text **Arizona** into the new fact and then press *Enter*:

   Another fact is added to the work area and is automatically linked to the first fact:

   ![Graph showing Arizona linked to American states]

6. Add the following facts using the same process:

   - **Alabama**
   - **Georgia**.

7. Click on a blank area on the fact map to stop using brainstorming.

   Your fact map should look like this:

   ![Fact map with Arizona, Alabama, and Georgia]

   If you wish to add more states, click on the button or the button.

**Exercise 9  Exporting fact maps**

In this exercise you will learn how to export a fact map to a Microsoft Word document.

1. Click on the button (on the File menu). Then **Open**.

   The fact map is opened and displayed in Microsoft Word. It is displayed in Document Outline view.

2. Close Microsoft Word.

   You can also export a fact map to Microsoft Word or to an HTML page by clicking on the File menu on the left-hand-side of the File toolbar and selecting Export. The Export Facts - Webpage window allows you to select the option you prefer.
Exercise 10  **Printing, saving and opening fact maps**

In this exercise you will learn how to print, save and open a fact map.

1. Click on the button (on the File menu).
   
   You will see the Print window displayed. Select your preferred print options and then click on the **Print** button.

2. Click on the File menu and then click on the button.
   
   You will see the File Download window.

3. Click on the **Save As**.
   
   The Save As window is displayed.

4. Browse to the folder in the directory in which you want to save the fact map, type the name **America** in the **File name** text box and then click on the **Save** button.

5. The Download complete window is displayed.

6. Close the Download window.

   Any time you need to save the fact map in future, you will have to override the file you just saved.

7. Click on the **File** menu and select the **Exit** option:

8. Click on the **Yes** button when you are asked to confirm the closure of the window.

9. Click on the button and allow access.

10. Click on the File menu and then the button.
    
    You will see the Open File window displayed:
11. Click on the **Browse** button.

   You will see the Choose file window displayed.

12. Locate the **America** fact map and then click on the **Open** button.

   You will see the Open File window re-displayed.

13. Click on the **OK** button.

14. The **America** fact map opens in the Fact Mapper window.

15. Close all open maps. You do not have to save them.

---

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to create a Fact Map.</td>
<td></td>
</tr>
<tr>
<td>How to add notes.</td>
<td></td>
</tr>
<tr>
<td>How to add images from the Image Library.</td>
<td></td>
</tr>
<tr>
<td>How to link facts.</td>
<td></td>
</tr>
<tr>
<td>How to change how the fact map is displayed.</td>
<td></td>
</tr>
<tr>
<td>How to brainstorm.</td>
<td></td>
</tr>
<tr>
<td>How to export the Fact Map.</td>
<td></td>
</tr>
<tr>
<td>How to print, save and open a Fact Map.</td>
<td></td>
</tr>
</tbody>
</table>
22. Using Screen Masking

In this section you will learn how to:

- use Screen Masking
- change the Screen Masking options
- use the spotlight option.

Exercise 1 Using Screen Masking

In this exercise you will learn how to use the Screen Masking.

1. Open a document in Microsoft Word and then click on the button on the Read&Write 11.5 Gold toolbar.
   The Windows system background colour changes to light blue.

2. Click on the button on the Read&Write 11.5 Gold toolbar.
   The Windows system background colour returns to white.

Exercise 2 Changing the display options

In this exercise you will learn how to change the colours and masking type used by Screen Masking.

1. Click on the drop down list and select Screen Masking Options.

2. You will see the Display tab of the Screen Masking Options window:

3. Select the Tint the line I'm typing on option from the Select Masking Type drop down list.

4. Select a blue colour from the Color used when masking the screen colour palette.
5. Adjust the **Transparent/Opaque** track bar until you have selected a more transparent colour, i.e. move the scale more to the left.

6. Click on the **OK** button.

7. Type the following text into a blank Microsoft Word document:

   **This is Screen Masking.**

   Notice how the Screen Masking facility tints the line of text you type on.

8. Click on the **button to turn off the facility.**

   You can practice setting up some of your own display options.

**Exercise 3 Using the spotlight**

In this exercise you will learn how to use the spotlight.

1. Click on the **drop down list and select** **Screen Masking Options**.

   You see the Screen Masking Options window.

2. Select the **Tint my whole screen** option from the **Select Masking Type** drop down list.

   You can only enable the spotlight when you have chosen to tint the whole screen.

3. Adjust the **Transparent/Opaque** track bar until you have selected a more opaque colour, i.e. move the scale more to the right.

4. Click on the Spotlight tab.

5. Make sure the **Use the Mouse Spotlight when tinting the whole screen** check box is selected.
6. Make the spotlight smaller by moving the **Height of Mouse Spotlight** track bar more to the left.

7. Click on the **Color of Mouse Spotlight** palette and choose a colour.

8. Click on the **OK** button.

9. Move your mouse across the screen and notice how the spotlight works.

10. Click on the ✅ button to disable the facility when you have finished.

The other Masking Types are as follows:

- Tint the window I’m typing in
- Tint everything except the window I’m typing in
- Tint everything except the line I’m typing on
- Underline the line I’m typing on
- Underline my mouse pointer
- Change system background color.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>☑</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Screen Masking.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to change the Screen Masking options.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to use the spotlight.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
23. Using the Speech Input facility in Vista/Windows7/8

In this section you will learn how to:

- set up the Speech Input
- create text using Speech Input
- correct text
- add words to the Speech Dictionary.

To complete this section, you must ensure that you are in a quiet room and are not likely to be distracted.

This exercise assumes that the Speech Input facility has not been previously used.

Exercise 1  Preparing to use the Speech Input facility

In this exercise you will learn how to start the Speech Input facility, correctly position the microphone and carry out a training exercise.

1. Click on the button on the toolbar.

You will see the Speech Input window displayed:

2. Type your name in the New Profile text box and then click on the OK button to add your user profile.

The Microphone Setup Wizard is displayed:

3. Follow the instructions in the wizard to ensure that the microphone is in the correct position.
When you have finished adjusting the microphone, the Speech Recognition Voice Training Wizard is displayed:

4. Follow the instructions in the wizard to train the Speech Input facility to recognise your voice.

You can pause the training at any stage by clicking on the button. The more training you do the better the Speech Input facility will be at recognising your voice.

Exercise 2  **Create text using the Speech Input facility**

In this exercise you will learn how to start the Speech Input facility and create text by reading into the microphone.

1. Click on the button on the toolbar.

You will see the Speech Input panel. It is currently in ‘Listening’ mode:

2. Open Microsoft Word.

3. Speak the following text into the microphone:

   ‘A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases.’

Don’t worry if the Speech Input makes a mistake. You will learn how to correct mistakes in the next exercise.

4. Click on the button on the toolbar.

The text you just spoke into the microphone is read back to you.
5. Click on the button on the Speech Input panel.

The Speech Input panel changes to ‘Sleeping’ mode.

You can toggle between the Listening and Sleeping modes by clicking on the button.

Exercise 3  **Correcting text using the Speech Input facility**

In this exercise you will learn how to correct any mistakes the Speech Input facility may have made.

1. Open a new Microsoft Word document.

2. Click on the button on the toolbar.

3. Speak some text into the microphone and stop **immediately** after a word is recorded incorrectly.

4. Speak the following into the microphone:

   **Correct that.**

   You will see the Alternates panel displayed:

5. Say the number displayed next to a word (or group of words) you would like to use instead.

   The Speech Input facility replaces the word in your text.
6. Speak some more text into the microphone and only stop after speaking several sentences, i.e. after the software has made a couple of mistakes.

7. Speak the following into the microphone:

   Correct ‘say the word that was recorded incorrectly’.

   The Alternates panel is re-displayed

   If the incorrect word appears more than once, each instance will have a number beside it. In this case, you speak the following into the microphone: Correct ‘number displayed beside the instance you want to correct’.

8. You can now either:

   • say the number displayed next to a word (or group of words) you would like to use instead. The Speech Input facility replaces the word in your text
   • click on or say Spell it if your correction does not appear in the Alternates panel.

   You will see the Spelling panel displayed:

9. Spell aloud the word you would like to insert in the text, in place of the original word, and then click on the OK button.

10. Close the Alternates panel.

**Exercise 4  Adding words to the Speech Dictionary**

   In this exercise you will learn how to add words to the Speech Dictionary. This is useful for any words that the Speech Input frequently mishears or does not recognise.

1. Click on the drop down list and select the Open Speech Dictionary option.

   You will see the Speech Dictionary window displayed:
2. Click on **Add a new word**.

You will see the second step of the Speech Dictionary window displayed:

3. Type the word **entrepreneurial** into the **Word or Expression** text box, and then click on the **Next** button.

You will see the third step of the Speech Dictionary window displayed:
4. Select the **Record a pronunciation upon Finish** check box, and then click on the **Finish** button.

You will see the fourth step of the Speech Dictionary window displayed:

5. Click on the **Record** button and then say the word **entrepreneurial** into the microphone.

You can hear the word read back to you by clicking on the **Listen** button.

6. Click on the **Finish** button.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to set up Speech Input.</td>
<td></td>
</tr>
<tr>
<td>How to create text.</td>
<td></td>
</tr>
<tr>
<td>How to correct text.</td>
<td></td>
</tr>
<tr>
<td>How to add words to the Speech Dictionary.</td>
<td></td>
</tr>
</tbody>
</table>
24. Using the Translator Facility
In this section you will learn how to:

- translate single English words into another language
- configure the Translator
- translate paragraphs of text into another language.

Type the following text into a blank Microsoft Word document:

A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases.

You must be online in order to use the Translator facility.

Exercise 1 Translating single English words into another language
In this exercise you will learn how to translate words from English into another language.

1. Click on the drop down list on the toolbar and select Single word translation.

2. Click on the button. You will see the Translation tab of the Translator window displayed.

3. Select the word ‘volcano’.

4. You will see the French translation of volcano. Click on it to have it read.
Exercise 2 Configuring the Single Word Translation facility

In this exercise, you will learn how to use the Preferences tab to configure the translation language, speech, text and display options.

1. Click on the Preferences tab.

2. Select the Spanish option from the Translation Language drop down list.

3. Click on the Translation tab.

You will see the word ‘volcano’ displayed in the Word to search text box and a list of Spanish translations displayed in the Suggested meanings for selected word panel.

4. Click on the Spanish translations to hear them read aloud.

5. Click on the Preferences tab in the Translator window.

6. Select the German option from the Translation Language drop down list.

7. Adjust the Voice Speed track bar to the setting ‘30’.

8. Make sure the Get selected text and captions radio button is selected to specify that you’d like to select words for translation by simply highlighting them in your document.

9. Click on the button in the Background color section and select a blue colour for the background of the text in the Translation tab.

10. Click on the Translation tab.
11. Highlight the word ‘occur’ in your text.

You can now see the translations for the word ‘occur’ in the **Suggested meanings for selected word** panel. Click on the translation to have it read. The translation panel will be displayed in the colours you have chosen and the voice will be at the speed you have selected.

**Exercise 3**  **Translating paragraphs of text into another language**

In this exercise you will learn how to translate paragraphs of text from English into another language.

1. Click on the drop down list on the toolbar and select **Paragraph translation**.

2. Highlight the following paragraph in your document:

   A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates.

3. Click on the button.

   You will see the Read&Write Paragraph Translator in a new browser window. A translation is shown in French.

4. Hover your mouse over the paragraph and then click on the button to hear it read aloud.

   The button will only be shown if there is a supported speech engine.

5. Close the browser window.
Exercise 4  Configuring the Paragraph Translation facility

1. Click on the drop down list on the toolbar and select **Paragraph translation** options. You will see the Paragraph Translation Options window displayed.

2. Select the **Spanish** option from the **To** drop down list under **Languages**.

3. Click on the **Background color** palette and select a **yellow** colour from the colour palette.

4. Click on the **OK** button.

5. Highlight the paragraph in your document (the same one you highlighted in step 2).

6. Click on the **button**. You will see the Read&Write Paragraph Translator redisplayed in a new browser window. A translation is shown in Spanish.

7. Hover your mouse over the paragraph and then click on the **button to hear it read aloud.**

8. Close the browser window.
## Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to translate a single word.</td>
<td></td>
</tr>
<tr>
<td>How to configure the Single Word Translator.</td>
<td></td>
</tr>
<tr>
<td>How to translate a paragraph.</td>
<td></td>
</tr>
<tr>
<td>How to configure the Paragraph Translator.</td>
<td></td>
</tr>
</tbody>
</table>
25. Using Study Skills

In this section you will learn how to:

- collect text from a webpage or a word document.

You can use Study Skills to highlight pieces of text which you may find of interest within a Microsoft Word document, Internet Explorer, Firefox or Chrome and collate the highlighted text into a new document.

To access Study Skills, click on the button until you can see the Study Skills buttons. The tooltip for this button will help you identify the buttons you need.

Exercise 1  Collecting text for your studies

In this exercise you will learn how to collect different types of text and then insert them into a new document in the order in which you want them displayed.

1. Open your Internet browser window and then open one of your favourite websites.

   Alternatively, open a Microsoft Word document of your choice.

2. Highlight some text on the page and then click on the button.

   Read&Write 11.5 Gold highlights the text in green. An example is shown below:

3. Highlight some more text on this page and then click on the button.

   Read&Write 11.5 Gold highlights the text in pink.

4. Repeat step 3 to highlight two further separate paragraphs in pink.

5. Highlight some of the text in pink and then click on the button.

   Read&Write 11.5 Gold de-selects the highlighted text in pink.

6. Open another one of your favourite websites.

   Alternatively, open another Microsoft Word document of your choice.

7. Highlight some text on the page and then click on the button.
Read&Write 11.5 Gold highlights the text in green.

8. Click on the (Collect highlights) button.

The Collect Highlights window is displayed:

9. Make sure the following options are selected:
   - the Page option is selected from the Color collections separation drop down list
   - the New line option is selected from the Highlighted items separation drop down list
   - Collect highlights from multiple documents checkbox

10. Select the Include bibliography checkbox and then select Harvard from the Bibliography format drop down list.

11. Click on the OK button.

Read&Write 11.5 Gold collects the highlighted text from both of the webpages (or Word documents) and inserts it into a new Microsoft Word document. It also inserts a bibliography at the bottom of the page.

12. Save your document and call it My Studies.


Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to collect text.</td>
<td></td>
</tr>
</tbody>
</table>
26. Vocabulary
In this section you will learn how to:

- create a vocabulary list.

**Exercise 1  Creating a vocabulary list for your studies**
In this exercise you will learn how to add words to a vocabulary list which you can use for your studies. A vocabulary list provides definitions and explanatory images for your selected words.

1. Open your Internet browser window and then a website of your choice.
   Alternatively, open a Microsoft Word document of your choice.

2. Highlight a word on the page and then click on the (Highlight green) button to add it to your vocabulary list. Repeat this step until you have added several words to your list.

3. Click on the button on the toolbar.
   You will see the Vocabulary window displayed:

   ![Vocabulary window]

   Your selected words are listed in the **Vocabulary list** box.

4. Type ‘happy’ in the **Add new word to list** text box and then click on the **Add** button to add the word to the **Vocabulary list** box.

5. Type ‘My text’ in the **Subject/Title** text box.

6. Click on the **OK** button.
Your Vocabulary List is displayed in Microsoft Word, complete with definitions and explanatory images:

7. Type the following text in the Notes column for the word ‘happy’:

   A positive state of mind.

8. Save your document and call it My text.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>✔</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to create a vocabulary list.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
27. Creating a Word Cloud

In this section you will learn how to:

- create a Word Cloud from your own text
- create a Word Cloud from a Read&Write 11.5 Gold word bank
- alter the Word Cloud options.

Exercise 1  Creating a Word Cloud from your own text

In this exercise you will learn how to add words to create a word cloud from your own text. A Word Cloud provides the most important words in the text you have selected.

1. Open your Internet browser window and then a website of your choice. The Word Cloud works best if you have a good amount of text so try and have a webpage with lots of text.

2. Select the text and click on the button.

3. The Word Cloud panel will appear with the text you have selected:

4. Click on Create.

5. A Word Cloud will be created something like this:
6. Click on one of the words and it will be read for you.

7. To close the Word Cloud click on the button. You will be asked if you wish to save it.

8. Click on Yes. Give the Word Cloud a name and then click on Save.

9. To open the Word Cloud again click on the drop down and select Open Word Cloud.

10. Navigate to where you saved the Word Cloud and click on Open.

11. To close the Word Cloud click on the button again.

**Exercise 2 Creating a Word Cloud from a word bank**

1. To create a Word Cloud from one of the Read&Write 11.5 Gold word banks click on the button.

2. The Word Cloud panel opens:

3. Select the word bank you wish to use then click on Create.
4. A Word Cloud will be created like this:

5. To close the Word Cloud click on the button. You will be asked if you wish to save it.

6. Click on Yes. Give the Word Cloud a name and then click on Save.

**Exercise 3  **Alter the Word Cloud options

You can alter how the Word Cloud works.

1. Click on the drop down and select **Word Cloud Options**.

2. The Word Cloud Options panel opens:

3. From here you can choose:

   - The number of words or phrases in the Word Cloud – simply type in the number you wish to be included.

   - The colour of the cloud – choose from blue, green or red.
• The shape of the cloud – choose from cloud or list.
• Set the Word Cloud as top – this means that the Word Cloud will always appear on top of any document you have open.
• Include numbers – for example dates.
• Include less frequent words.
• Speak the word when clicked.
• Insert the word when clicked.

4. Make your selections and then click OK.

5. Complete the previous exercise again to see the effect of the changes you have made.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to create a Word Cloud from text.</td>
<td></td>
</tr>
<tr>
<td>How to create a Word Cloud from a word bank.</td>
<td></td>
</tr>
<tr>
<td>How to alter the Word Cloud options.</td>
<td></td>
</tr>
</tbody>
</table>
28. Using a Voice Note

In this section you will learn how to:

- insert a Voice Note in to Microsoft Word.

Exercise 1  Adding a Voice Note to MS Word

In this exercise you will learn how to insert a voice note into Microsoft Word. You can use this to make comments or add instructions to a document.

1. Open a Microsoft Word document.
2. Click in the document where you would like to place the Voice Note.
3. Click on the button.
4. The Voice Note panel will appear:

5. When you are ready click on **Start Recording**.
6. Speak into your microphone what you would like to say.
7. When you have finished click on **Stop Recording**.
8. You can Replay the Voice Note by clicking on **Replay**.
9. Click on **Insert** to put the Voice Note into the document.
10. In the Word document you will see an icon similar to this: 🎙️
11. You can listen to the Voice Note by double clicking on this icon.

If you wish you can save the Voice Note separately from the Word document by clicking on **Save**.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to add a voice note to MS Word.</td>
<td></td>
</tr>
</tbody>
</table>
29. Saving and Loading Your Settings

In this section you will learn how to:

- save your settings
- load your personal settings.

**Exercise 1  Save your personal settings**

There may be occasions when you use Read&Write 11.5 Gold on different unconnected computers. In this exercise you will learn how to save your personal settings to a memory stick. You can then load your personal settings from the memory stick to any computer you wish.

It is possible to save your personal settings to a location of your choice, for example, on your hard drive. However, in this exercise, you are required to save them to a memory stick.

1. Click on the drop down list and select **Save my settings**.
2. The Browse For Folder panel will appear.
3. Navigate to your USB and select it then click **OK**.

Your settings have now been saved onto the USB.

**Exercise 2  Load your personal settings**

To load your personal settings at another location:

1. Insert your USB drive into your USB port.
2. Click on the drop down list and select **Load my settings**.
   
   The Browse For Folder window is displayed.
3. Browse for the USB drive on your computer and then click on the **OK** button to load your personal settings.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to save personal settings.</td>
<td></td>
</tr>
<tr>
<td>How to load personal settings.</td>
<td></td>
</tr>
</tbody>
</table>